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Important Information
Except as otherwise expressly stated in the License that accompanies a
program, Texas Instruments makes no warranty, either express or
implied, including but not limited to any implied warranties of
merchantability and fitness for a particular purpose, regarding any
programs or book materials and makes such materials available solely on
an "as-is" basis. In no event shall Texas Instruments be liable to anyone
for special, collateral, incidental, or consequential damages in connection
with or arising out of the purchase or use of these materials, and the sole
and exclusive liability of Texas Instruments, regardless of the form of
action, shall not exceed the amount set forth in the license for the
program. Moreover, Texas Instruments shall not be liable for any claim of
any kind whatsoever against the use of these materials by any other
party.

FCC Statement
Note: This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or
more of the following measures:
•

Reorient or relocate the receiving antenna.

•

Increase the separation between the equipment and receiver.

•

Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

•

Consult the dealer or an experienced radio/TV technician for help.

© 2007 Texas Instruments Incorporated
Microsoft®, Windows®, Excel®,Vernier EasyTemp®, Go!®Temp and
Go!®Motion are trademarks of their respective owners.
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Introduction
The TI-Nspire™ math and science learning
handheld
This guidebook provides information about a powerful, advanced
learning handheld available from Texas Instruments: the
TI-Nspire™handheld.
Your learning handheld comes equipped with a variety of pre-installed
software applications that have features relevant to different subjects
and curriculums.
Extend the reach of your TI-Nspire™ handheld with accessories, such as
the TI-Nspire™ computer software, TI-Nspire™ ViewScreen™ Panel and
TI-Nspire™ Computer Link Software.

How to use this guidebook
This guidebook is intended to provide instruction for the basic operation
of the TI-Nspire™ handheld.
The chapters in this guidebook include:
Getting Started - Provides start up information for the learning
handheld, and offers students and educators an overview of the basic
operations of the TI-Nspire™ handheld.
Working with Documents - Provides instruction for creating and
working with documents.
Using Calculator- Provides an overview of the Calculator application.
Using Graphs & Geometry - Provides an overview of the Graphs &
Geometry application.
Using Lists & Spreadsheet- Provides an overview of the Lists &
Spreadsheet application.
Using Data & Statistics - Provides instruction for using the Data &
Statistics application to analyze data created in other applications.
Using Notes- Provides an overview of the Notes application.
Data Collection - Provides an overview of the Data Collection tool.
Service and Warranty Information - Includes service and warranty
information and contact information for technical support.
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Where to find more information
The remainder of the product information is available in electronic form.
The comprehensive guidebook for using the TI-Nspire™ handheld is
included on the CD-ROM that came with your learning handheld. This
guidebook is also available online as a free download at
education.ti.com/guides.
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Getting Started
Your TI-Nspire™ handheld operates in two modes:
•

TI-Nspire

•

TI-84 Plus Silver Edition

There are two keypads, one for each mode, but your handheld has only
one operating system. The operating system for the TI-84 Plus keypad is
bundled with the TI-Nspire™ operating system. Both mode operating
systems are updated when you update the OS for the handheld. The
TI-84 Plus mode OS cannot be installed separately using a stand-alone
TI-84 Plus OS.
To learn about the capabilities and features of the TI-84 Plus mode, see
the TI-84 Plus guidebook on your CD or at education.ti.com. The
capabilities and features of the TI-Nspire mode are described in this
guidebook.
Note: There are many TI-84 Plus applications (Apps). Apps that are
certified by TI to be compatible with your TI-Nspire handheld will
operate correctly. All apps preinstalled on your handheld are certified.
Other applications that have not been certified may also operate
correctly, but some will not.

Dual Keypads
Your TI-Nspire™ handheld works with two keypads: the first is the
TI-Nspire™ keypad and the second is the TI-84 Plus keypad.

TI-84 Plus keypad (on left) and TI-Nspire keypad
(attached to handheld)

Getting Started

3

Changing the keypad
Caution: When changing keypads, be certain that the handheld is
completely powered down before removing the keypad. Removing the
keypad before the display clears may result in loss of data.
1.

Remove the cover, and turn the
handheld over. Slide the latch
release to the right.
The keypad releases.

2.

Turn the handheld right side up,
and slide the keypad away from
the display screen.

3.

Lift the keypad off the
handheld.

4.

Insert the other keypad.
Ensure that it fits comfortably
into the guides on the bottom
and sides of the handheld.

5.

Note: The keypad does not slide
in from the bottom edge of the
unit. Instead, fit it into the
guides just above the batteries.
When the keypad is properly
seated on the handheld, push
the keypad toward the display
screen.
The keypad clicks into place
when properly seated and
completely inserted into the
handheld.
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TI-Nspire™ handheld keys

d

cDisplays the

Removes
menus or dialog
boxes from the
screen.

home menu.

bDisplays

application or
context menu.

e Moves to the

next entry field.

.

Clears
(erases) the entry
line or deletes
selected object.

/ Provides

access to the
function or
character shown
above each key.

kDisplays the
catalog for
entering
commands.

g Makes the next
character typed
upper-case.

· Evaluates an
expression,
executes an
instruction, or
selects a menu
item.

w Turns on the

TI-Nspire handheld.

xClick button

Selects an object on the screen.
NavPad
Press , , , or
to move the cursor.

345
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/ + x or pressing and holding x
Displays the grab cursor ÷ so you can
grab an object on the screen.

Getting Started
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Keyboard shortcuts
Use the following keyboard
shortcuts to perform common
functions.
Editing Text
cut

/X

copy

/C

paste

/V

undo

/Z

redo

/Y

Inserting Characters, Symbols
display character
palette

/k

not equal to

/=

underscore

/_

|

/>

{

/<

semi-colon (;)

/:

display math
template palette

/r

%

/S

save current
document

Navigation
Home

/7

End

/1

Page Up

/9

Page Down

/3

Up a level in the
hierarchy

/£

Down a level in the
hierarchy

/6

Navigating in Documents
displays previous
page

/¡

displays next page

/¢

displays Page Sorter

/£

Wizards and Templates
add a column to a
matrix

g@

add a row to a matrix

@

integration template

g+

/j

derivative template

g-

$

/"

Modifying Display

degree symbol

/'

increase contrast

/+

backslash ( \ )

gp

decrease contrast

/-

power off

/w

Managing Documents
create new document

/N

insert new page

/I

select application

/K
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Initial startup
The TI-Nspire™ math and science learning handheld uses four AAA
batteries, which are provided with the product.

Replacing batteries
Caution: When removing the keypad to change batteries, be certain
that the handheld is completely powered down. Removing the keypad
before the display is cleared may result in loss of data.
1.

Remove the keypad from the
handheld.

2.

Carefully remove the batteries.
Caution: You may need to use a
tool to remove the batteries as
they fit tightly in the unit. If you
use a tool, be careful not to
damage either the batteries or
the handheld.

3.

Insert fresh batteries.
Ensure that the + side of each
battery faces away from the
display screen.

4.

Replace the keypad.

Battery Precautions
Take these precautions when replacing batteries.
•

Do not leave batteries within the reach of children.

•

Do not mix new and used batteries. Do not mix brands, or types
within brands, of batteries.

•

Do not mix rechargeable and non-rechargeable batteries.

•

Install batteries according to polarity (+ and -) diagrams.

•

Do not place non-rechargeable batteries in a battery recharger.

•

Properly dispose of used batteries immediately.

Getting Started
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•

Do not incinerate or dismantle batteries.

•

Seek medical advice immediately if a cell or battery has been
swallowed.

Additional precautions for rechargeable batteries
•

Use only the charger recommended for the cell or battery, or the one
that was provided with the original equipment.

•

Remove the cell or battery from the charger or alternating current
adapter when not in use or being charged.

•

Use of the battery in other devices may result in personal injury or
damage to equipment or property.

For proper disposal of used batteries
•

Do not mutilate, puncture, or dispose of batteries in fire. The
batteries can burst or explode, releasing hazardous chemicals.
Discard used batteries according to local regulations.

Adjusting the contrast
To lighten the display, press and hold / and tap -.
To darken the display, press / and tap +.

Turning the handheld on and off
To turn the handheld on, press w.
To turn the handheld off, press / w. The next time you turn on the
handheld, it is in the same state as when you left it. The settings and
memory contents are retained.

Automatic Power Down
To prolong battery life, Automatic Power Down turns off the handheld
after several minutes of inactivity. The next time you turn on the
TI-Nspire™ handheld, it is exactly as you left it.

Turning on your TI-Nspire™ handheld for the first
time
f

After installing the batteries included with your new handheld,
press w to turn the handheld on.
A progress bar displays while the operating system loads.
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Choosing a language
When loading is complete, you are prompted to select the language
to display on the handheld.

1.

Press 6 until the language you wish to display is highlighted, and
then press the click button on the NavPad (x) or · to select it.

2.

Press e to highlight the OK button, and press x or · to select
it.

Choosing a font size
Next, you are prompted to select the font size you wish to use to
display text on the handheld.

1.

Press 6 until the font size you wish to display is highlighted, and
then press x or · to select it.

2.

Press e to highlight the OK button, and press x or · to select
it.
Note: You can reset the font size on your handheld at any time by
changing the system settings.

Getting Started
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When you have selected the font size, the Welcome screen displays.
This screen describes a few of the basics of using your new handheld.
Press 6 on the NavPad to scroll down through the document.

Once you have finished with the welcome screen, press e to
highlight the OK button, then press x or · to display the home
menu.

The Home menu
The Home menu provides a starting point for all activities on your
handheld. Use the Home menu to perform the following tasks:
•

creating new documents

•

opening and managing existing documents

•

viewing and changing system and document settings

•

viewing hints for operating the handheld.

Using the Home menu
The Home menu displays when you power on your handheld for the first
time.
Note: To return to the Home menu from any other location, press c.
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1.

Press the arrows on the NavPad (3, 4, 5, or 6 ) to move among the
options on the Home menu.
A brief description of what each option does displays at the bottom
of the screen.
Note: Not all options are available at all times. If an option is not
available, its icon is grayed-out on the home menu.

2.

Press x or · to select a highlighted option, or press the number
associated with the option.
For example, press 6 to open a new document.

To learn more about applications and documents, see the Working
with Documents chapter.

The TI-Nspire™ handheld screen
The handheld screen provides information about the document you are
working in, as well as the system settings and status. The example below
illustrates the main elements of the handheld screen. A description of
each element follows.

Getting Started
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Ë

Ì

Ê

Ê
Ë
Ì

Page tabs - indicate the problem number followed by the page
number.
System Settings - display the system settings in use, what modifier
keys are in use, and provides a snapshot of battery status.
Status icons - indicate whether any modifier keys are active, and
display battery and memory status.

Viewing status information
The icons that display across the top of the handheld screen provide a
quick look at the operating status of the handheld. Icons indicate
whether any modifier keys are active, and display the current page
number and the total page number. Battery status and low memory
indicators also display in this area.
Icon

critical

Indicator

Action

Active key

Indicates whether / or g
keys are active.

Battery Status

Indicates battery life.

good
low

Viewing system settings
The system information menu allows you to view the following system
information:
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•

Document settings

•

System settings

•

Handheld status

•

About screen

Not all options are accessible at all times. For example, if no document is
open, you cannot view document settings. When an option is not
available, it appears in light gray on the menu.

Document settings
Document settings control how the handheld displays and interprets
information in each document. All numbers, including elements of
matrices and lists, display according to the document settings.

Document settings Options
The following table lists the document settings and their possible values.
Field

Values

Display Digits

Float
Float1 - Float12
Fix0 - Fix12

Angle

Radian
Degree
Gradian

Exponential Format

Normal
Scientific
Engineering

Real or Complex

Real
Rectangular
Polar

Exact or Approx.

Auto
Exact
Approximate

Vector Format

Rectangular
Cylindrical
Spherical

Getting Started
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Field

Values

Base

Decimal
Hex
Binary

Changing document settings
1.

Press / c 1 6 to display the Document Settings dialog box.

2.

Press e to move down through the list of settings. (Press 3 if you
need to move back up through the list.)

3.

When you reach the setting that you want to change, press 6 to
expand the selection list.

4.

Press the 5 and 6 keys to highlight the option you wish to select
and press x or · .

5.

Press the 4 key until the OK button is highlighted.

6.

Press x or · to apply the new document settings.
Note: If you want to apply the new settings to the device, highlight
Apply to System and press x or ·.

System settings
System settings apply default settings to all documents on the handheld.
When you create a new document, by default, it uses the system settings
to control how the document displays and interprets information.
Document settings applied to an individual document override the
system settings. System settings also control the language and the font
size for the handheld.
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Changing system settings
1.

Press c 8 2 to open the System Settings window.

2.

Press e until the category of settings you want to change is
highlighted.

3.

Press 6 to display the list of possible settings.

4.

Press 6 to highlight the setting you wish to select.

5.

Press x or · to select the new setting.

6.

When you have changed all the settings to suit your needs, press
e until OK is highlighted, and press x or · to apply your
changes.
Note: Click Defaults to return the handheld to the factory settings.

Handheld status
The Handheld Status screen shows the amount of memory (in bytes)
used by all documents and variables on your TI-Nspire™ handheld. The
Handheld Status screen displays the following information:

Getting Started

15

•

Storage Capacity

•

Space Used

•

Free Space

•

Battery Status

Checking available memory
1.

Press c 8 3.

2.

Press x or · to dismiss the Handheld Status screen.

Freeing Memory
If you have insufficient memory to store documents on your handheld,
you must free memory to create the space you need. To free memory,
you must delete documents and/or folders from memory. If you wish to
keep the documents and folders for use later, you can back them up to
another handheld or to a computer.

Deleting items from memory
If have documents stored on your handheld that you no longer need, you
can delete them from memory to create additional space.
Before you delete documents from memory, consider restoring sufficient
available memory by copying files to another handheld.
1.

Open My Documents.
Press c 7.

2.

Press £ or ¤ to select the folder or document you want to delete.

3.

Press ..
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4.

Press x or · to confirm that you want to delete the file.
Note: Press d to cancel the deletion. Press / Z to cancel.

Using connection cables
Your TI-Nspire™ handheld comes with connection cables that allow you
to share files with both a computer and another device. Different cables
work with each keypad.

USB cables
You can use USB cables to connect two TI-Nspire handhelds, to connect a
TI-Nspire handheld to a computer, or to connect one TI-Nspire™
handheld using TI-Nspire™ TI-84 Plus keypad to another.

TI-Nspire™ USB connection
cable to connect handheld to a
computer using TI-Nspire
Computer Link software.

TI-Nspire™ handheld miniUSB cable to connect two
TI-Nspire handhelds

TI-84 Plus Mode cables
If you already have TI-84 Plus handhelds and use the I/O port for
connectivity, you can use the same cables to connect to a TI-Nspire
handheld using the 84 keypad.

USB connection cable to
connect handheld to a
computer using TI Connect
software.

Getting Started

TI-84 Plus I/O device-to-device
connection cable
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Backing up files to another handheld
To back up files to another TI-Nspire™ handheld, follow the steps below.
Complete instructions for connecting two handhelds are included in the
electronic version of the handheld guidebook, provided on the CD that
came with your handheld.

Connecting two TI-Nspire™handhelds with the USB unit-tounit cable
The TI-Nspire™ handheld USB A
port is located at the center of the
top of the handheld.
1.

Firmly insert either end of the
USB unit-to-unit cable into
the USB A port.

2.

Insert the other end of the
cable into the receiving unit’s
USB A port.

Sending a document
1.

Press c 7 to open My Documents on the sending unit.

2.

Press the 5 and 6 keys to highlight the document you want to send.

3.

Press / c 1 5 to select Send from the Document menu.

4.

When the file transfer is complete, a message displays on the
receiving unit.

Connecting a TI-Nspire™ with TI-84 Plus Keypad to a TI-84
Plus handheld
TI-Nspire™ TI-84 Plus keypad I/O link
port is located at the bottom edge of
the keypad. The TI-84 Plus I/O link port
is located at the top left edge of the
graphing calculator.
1.

Firmly insert either end of the I/O
unit-to-unit cable into the port.

2.

Insert the other end of the cable
into the other graphing calculator’s
I/O port.
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Connecting the TI-Nspire™ handheld to a computer
1.

Firmly insert the mini-USB end
of the cable into the port at the
top of your handheld.

2.

Firmly insert the USB end of the cable into the USB port of
the computer.

Upgrading the Operating System
You can upgrade the OS on your TI-Nspire™ handheld using your
computer and TI-Nspire™ Computer Link Software. You can also transfer
the OS from one handheld to another.
Warning: Upgrading the operating system will delete all TI-84
applications and files. Before installing an OS upgrade, you should use TI
Connect to back up all TI-84 applications and files to a computer. You can
copy them back to the handheld when the OS upgrade is complete.
If there is not enough room on the receiving handheld for the upgrade,
the sending handheld is notified. The only time documents can be
affected by an OS installation is if the receiving handheld has a corrupted
OS. In this situation, documents may be affected by OS restoration. It is a
good practice to back up your important documents and folders before
installing an updated operating system.
See the important information below concerning batteries before
performing an OS upgrade.

Important Operating System download information
It is always a good practice to install new batteries before beginning an
OS download.
When in OS download mode, the Automatic Power DownTM (APD)
feature does not function. If you leave your handheld in download mode
for an extended time before you begin the downloading process, your
batteries may become depleted. You will then need to replace the
batteries with new batteries before downloading.

Where to get Operating System upgrades
For up-to-date information about available OS upgrades, check the Texas
Instruments Web site at http://education.ti.com.

Getting Started
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You can download an OS upgrade from the Texas Instruments Web site
to a computer, and use a USB computer cable to install the OS on your
TI-Nspire™ handheld.
For complete information, refer to the instructions in the chapter on
TI-Nspire™ Computer Link Software.

Backing up files to a computer
Use the TI-Nspire™ Computer Link Software or TI Connect (with the TI-84
Plus keypad) to back up the contents of your handheld to a computer.
TI-Nspire™ Computer Link Software and TI Connect software are
available on the product CD that came with your handheld.

Resetting the memory
The Reset button on the underside of the handheld resets all memory.
When resetting all memory on the TI-Nspire™ handheld, RAM and Flash
memory is restored to factory settings. All files will be deleted. All system
variables are reset to default settings.
Caution: Before you reset all memory, consider restoring sufficient
available memory by deleting only selected data. If you reset all memory,
the pre-installed apps on your handheld will be deleted.
To reset all memory on the handheld, follow these steps.
1.

Use a paper clip or ball point pen to press the Reset button on the
underside of the handheld.

2.

Hold for three seconds, and release.
Handheld memory is cleared.

When you clear memory, the contrast cometimes changes. If the screen is
faded or blank, adjust the contrast by pressing / + or / -.
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Displaying the About screen
The About screen displays information about theTI-Nspire™ handheld
type, the Operating System (OS) Version, and Product Identification (ID).
To display the About screen, press c 8 4.

For information regarding OS updates, see the chapter Transferring Files
in the electronic version the the handheld guidebook. This guidebook is
available on the CD that came with your handheld, or on the Texas
Instruments web site: http://education.ti.com/guides.

Viewing Hints
Hints provide helpful information for navigating the handheld. To view
Hints, press c 9.

Getting Started
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Using the catalog
Use the catalog to access a list of TI-Nspire™ commands and functions,
units, symbols and expression templates. Commands and functions are
listed alphabetically. Commands or functions not beginning with a letter
are found at the end of the list. (&, /, +, -, etc.).
The catalog window uses five tabs to categorize commands, special
characters and templates:
contains all commands and functions, in alphabetical
order
contains all math functions
provides a symbol palette for adding special characters.
contains math templates for creating two dimensional
objects, including product, sum, square root and integral.
shows Public library (LibPub) objects.

Opening the catalog
1.

Press k to open the catalog.

2.

Press the number key for the category of the item.
For example, press 4 to show a table of symbols.

3.
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Press 6 until the item you want to insert is highlighted.
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Notice that a syntax example for the selected item displays at the
bottom of the screen.
Note: To see additional syntax examples of the selected item, press
e, and then press · to maximize or minimize the Help. To move
back to the selected item, press g e.
4.

Press · to insert the item.

Using Wizards
Some functions have a wizard to help you enter function arguments. To
use the wizard, press e until the Use Wizard box is highlighted. Press

x or · to select the check box.
Entering special characters
The symbol palette contains a subset of the objects found in the catalog.
1.

To display the symbol palette, press / k.

2.

Press 3, 4, 5oor 6 until the item you want to insert is highlighted.

3.

Press · to insert the item.

Entering Math expressions
Math expression templates help you create two dimensional objects,
including partial, product, sum, square root and integral.
1.

To display the math expressions palette, press / r.

Getting Started
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2.

Press 3, 4, 5oor 6 until the item you want to insert is highlighted.

3.

Press x or · to insert the item.

Entering international language characters
The ; key allows you to enter specially accented or punctuated
characters in applications that allow text input.
1.

Open an application that allows text input.

2.

Type the desired text.

3.

Position the cursor after the letter that you want to accent. For
example, "e" while in the French locale.

4.

Press ; on the keypad. Notice that the "e" changes to "é." Keep
pressing ; until you find the accented version of e that you want.
Press _ or the next letter of your text to accept the character and
continue typing.
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Working with Documents
The TI-Nspire™ handheld lets you save your work in documents, which
you can share with other handheld users, and those using the desktop
software. In fact, all of the work you do with the TI-Nspire™ handheld is
contained in one or more documents. The three main components
involved in organizing and saving work on your handheld are:
•

Documents

•

Page Sorter

•

My Documents

Documents
The TI-Nspire™ document model is simple and easy to use when you
understand its structure.
•

Each document is divided into one or more problems.

•

Each problem contains one or more pages.

•

Each page can be divided into as many as four work areas.

•

Each work area can contain any of the TI-Nspire™ math and science
learning technology applications (Calculator, Graphs & Geometry,
Lists & Spreadsheet, Data & Statistics and Notes).

Page Sorter
Although the handheld typically displays the pages in your document
one at a time, the Page Sorter lets you see all of the problems in your
document and all pages within each problem in thumbnail format. You
can use the Page Sorter to rearrange and delete pages, and copy a page
from one problem and paste it in another.

Working with Documents
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My Documents
My Documents is a file manager where you store and organize your
documents. Documents are stored in folders.

Creating documents
There are two methods for creating a document. You can create a blank
document and then add applications and apply a layout, or if no
document is currently open, you can create a document containing a
single application.

Creating a blank document
f

Press c 6 to open a document from the home menu, or use the
shortcut keys.
Shortcut keys: / N
A new document opens and displays a blank page with the Add
Application menu.

Note: The tab at the top left of the screen indicates that this is the
first page of the first problem.
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Adding an application
f

Press the number that corresponds to the application you wish to
add to the page.
For example, press 2 to add the Graphs & Geometry application to
the page. The application displays in the work area.

Creating a document with an application
If no documents are currently open, you can create a document with an
application already added.
f

Press c and select the number of the application you want to
create. For example, press c 3 to create a new Lists &
Spreadsheet page.
A new document opens with Lists & Spreadsheet on the page.

Note: If you are currently working in a document, this method adds
a new page, containing the selected application.

Working with Documents
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Working with applications
Once you have added an application to your page, there are three menus
that provide access to the features and functionality of the application,
and allow you to manipulate your documents. These menus are:
•

the Application menu

•

the Context menu

•

the Page Tools menu

Application menu
The Application menu displays tools for working with a specific
application. Each application has a unique menu.

Using the Application menu
1.

If you are on a blank page, Press b to display the Application
menu. The menu displays applications that you can add to the page.

2.

Press the number of the application you want to add to the page.
For example, press 3 to add the Lists & Spreadsheet application.
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3.

Press b to display the Application menu.
When you have an application on a page, the Application menu
displays options for working with the current application. The
example below displays the Application menu for the Lists &
Spreadsheet application.

Context menu
The context menu displays options that are specific to the selected object
or the current cursor location.

Using the Context menu
f

To access a context-sensitive menu from an application, press
/ b.
In the example below, the context menu displays options available
for the selected cell in Lists & Spreadsheet.
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Page Tools menu
The Page Tools menu allows you to move between pages, modify page
layout, insert pages or problems, delete pages and change document
settings.

Using the Page Tools menu
1.

Press /

c to display the menu.

2.

Press the number of the option you wish to select. For example, to
change the page layout, press 5.

Changing the page layout
When you create a new document, it contains space to add one
application. If you need to add more than one application to a page, you
can change the layout to accommodate as many as four applications.
You can choose a standard layout, provided as a menu item, or you can
customize a layout to suit your needs.

Choosing a standard layout
1.
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Press / c 5 to display layout options.
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2.

If you want to select a standard layout, press 2.

3.

Press the number that corresponds to the layout you want to apply
to the page.
For example, press 2 to create a two-pane layout, divided
vertically on the page. The page is divided into the layout design you
have selected.

4.

Press / e to move to the right pane on the page.
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5.

Press the number of the application you want to add the new pane.
For example, to add the Graphs & Geometry application to the right
pane, press 2.

Note: If you need to change the layout of the page to add or delete
applications, you can do so at any time.

Creating a custom layout
If the standard layouts do not meet your needs, you can customize the
space allotted to applications on a page.
1.
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Press / c 5 to display layout options.
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2.

Press 1 to select the custom split option.
The standard layout displays, with a blinking divider between the
application panes.

3.

Press £, ¤, ¡ or ¢ to move the divider to adjust the height and
width of the panes in the layout.
Note: Press + or - to select a defined layout.

4.

Press xor · to accept the layout dimensions.

Repositioning applications on a page
If you want to change the position of applications on a page with
multiple applications, you can do so by "swapping" the positions of two
applications.

Swapping applications
1.

2.

Select Swap Applications from the Page Layout menu.
Press /

c54

Press /

e to select the application you want to move.

The selected application is surrounded by a heavy, flashing black
border, and the Swap App cursor é displays on the screen.
Note: On a two-pane page layout, the selected application
automatically swaps position with the opposite pane. Press x
or · to complete the swap.
3.

Press £, ¤, ¡ or ¢ to position the cursor over the application you are
targeting to swap.
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4.

Press xor · to complete the swap.
Note: Press d to cancel the swap.

Adding a problem to a document
A document can contain as many as 30 problems. To add a new problem:
1.

Press /c41.
A new problem with one page is added to the document.

Note: The tab at the top left of the screen indicates that this is the
first page of the second problem.

2.

Press the number of the application you want to add to the new
page.

Adding a page to a problem
Each problem can contain up to 50 pages. To add a new page to a
problem:
f
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Press /c42 to add a blank page
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or
f

Press c to display the Home menu, then press the number of the
application you’d like to add to the new page in the problem.
For example, press c 1 to add a new page with the Calculator
application.
Shortcut keys: / I.
A new page is added to the current problem.

Note: The tab at the top left of the screen indicates that this is the
second page of the second problem.

Moving through pages in a document
Use the following keys to navigate through your documents.

/ 3

displays the previous page.

/ 4

displays the next page.

/ 5

displays the Page Sorter.

Saving a document
If you are working in a document and want to save it:
1.

Press / c 1 3 or
Shortcut keys: / S
If you are saving the document for the first time, you will be asked
which folder to save it to, and what to name the document.
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2.
3.

Type a name for the new document.
If you want to save the document in a different folder, press

g e and type a new folder name, or press x to view a list of
existing folders.
4.

Press ¤ to highlight the folder name and press x to select it.

5.

Press e to select OK.

6.

Press xor · to save the document.

Viewing and reordering pages in a document
The Page Sorter displays all of the problems in your document and all
pages within each problem in thumbnail format. You can use the Page
Sorter to rearrange and delete pages, copy a page from one problem and
paste it in another and apply templates to pages.

Opening the Page Sorter from a document
f

Press /c33 or
Shortcut keys: / £.
The Page Sorter screen displays all of the problems and pages in the
current document.
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Reordering pages in a problem
To move a page within a document from the Page Sorter:
1.

Use the 3 and 4 keys to select the page you want to move.
A heavy border around the page indicates that it is selected.

2.

Either press and hold xor press / xuntil the grab cursor

÷displays.
3.

Press 3 , 4,

5 and 6 to move the page to the desired position.

4.

Press x or · to finish the move.
Note: You can press d to cancel.
The page moves to the new location within the problem, and the
counter adjusts accordingly.
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Copying a page to another problem
To copy a page from one problem to another in the same document:
1.

Press 3 , 4,

5 and 6 to select the page you want to copy.

A heavy border around the page indicates that it is selected.

p

2.

Press / C to copy the page.

3.

Press 3 , 4, 5 and 6 to move the page to the desired position in the
new problem.

4.

Press / V to paste the page in the new location.
The page moves to the new location within the problem, and the
counter adjusts accordingly.

Copying a page to another document
To copy a page from one document to another document:
1.

Press 3 , 4,

5 and 6 to select the page you want to copy.

A heavy border around the page indicates that it is selected.
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2.

Press / C to copy the page.

3.

Press c 7 to Open My Documents.

4.

Press 5 and 6 to highlight the folder containing the document you
want to copy the page to.

5.

Press 4 to open the folder, or press b 3.

6.

Press the 5 and 6 keys to highlight the document.

7.

Press x or · to open the document.o

8.

Press / 5 to display the Page Sorter.

9.

Press 3 , 4, 5 and 6 to move the page to the desired position in the
document.

10. Press / V to paste the page in the new location.
The page moves to the new location within the problem, and the
counter adjusts accordingly.

Document settings
You can change the mode settings for a document when you want to use
settings different from those you have specified for the handheld. For
instance, if you want to change the angle mode or exponential format
used by the current document without changing the settings for every
document on the handheld, use Document Settings to do so.

Changing document settings
1.

Press c81 to display the Document Settings dialog box.
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2.

Press e to move down through the list of settings.
Note: Press g e if you need to move back up through the list.

3.
4.

When you reach the setting that you want to change, press 6 to
expand the selection list.
Press the 5 and 6 keys to highlight the option you wish to select
and press xor ·.

5.

Press e until the OK button is highlighted.

6.

Press x or · to apply the new document settings.
Note: If you want these settings to apply to future documents also,
highlight Apply to System and press x.
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Managing documents
My Documents is a file manager where you store and organize your
documents. The example below illustrates the My Documents screen with
its main parts labeled. Following the screen, you can find descriptions of
each labeled part.

Ã
À

Ä

Á
Â

À
Á
Â
Ã
Ä

Expanded folder
Unsaved document
Collapsed folder
System status indicators
File size

Opening My Documents
To open My Documents:
f

Press c 7.
Note: If you are working in a document, press / 5 / 5.
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The My Documents screen opens, displaying all folders and files on
the handheld.

Opening documents
To open a document:
1.

Press 5 and 6 to highlight the folder containing the document.

2.

Press xor · to open the folder.

3.

Press the 5 and 6 keys to highlight the document you want to
open.

4.

Press xor · to open the document.o

Expanding folders
To expand a single folder:
1.

Press 5 and 6 to highlight the folder.

2.

Press xor · to open the folder.

3.

The icon changes to the opened icon
all documents within the folder.

and a list displays showing

Expanding all folders
To expand all folders on the My Documents screen:
f

Press b 5.
All folders expand to display their contents.

Renaming folders or documents
To rename a folder or document:
1.

Press the 5 and 6 keys to highlight the document or folder you
want to rename.

2.

Press b 2.
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The document or folder name is highlighted.
3.

Type a new name and press · to complete the change.
Note: Press d to cancel.

Collapsing folders
To collapse a single folder:
f

Press 3 tto collapse an expanded folder. The icon returns to the closed
folder icon
the screen.

and the contents of the folder no longer display on

To collapse all folders:
f

Press b 6 to collapse all folders.

Creating folders
You can create folders two different ways:
•

You can create a folder when you save a new document: The Save
and Save As... menu commands allow you to enter a new folder
name for the document.

•

You can create a folder directly from the My Documents screen. Press
b 1. Type a name for new folder, and press xor · to add it.

File and folder naming conventions
Folder names must be unique. File and folder names can be very long,
and can include almost all characters, including spaces and punctuation.

Deleting documents and folders
1.

Press 5 and 6 to highlight the document or folder you want to
delete.
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2.

Press / c 2 6 or press ..

A dialog box displays, confirming that you want to delete the file or
folder.

3.

Press xor · to select Yes.
The document is deleted.

Note: Press / c 2 1 to Undo a file or folder deletion.

Duplicating documents and folders
Use Copy (/ C) and Paste (/ V) to duplicate documents and
folders.
To copy a document to another folder, select the desired folder, then
paste.

Recovering deleted documents
Most operations performed in My Documents can be undone. Press
/ Z (Undo) to cancel the last operation until the deleted document is
restored.
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Linking values on pages
Variable linking is a powerful tool for building and exploring
mathematical models. Values and functions created or defined in one
application can interact with other applications (within the same
problem) to share data.
There are a few things to keep in mind when using linked items:
•

Values can be linked between applications on one page or between
different pages of the same problem.

•

Since all applications are linked to the same actual data, if you delete
it from any application, then all references to the data are lost.

•

If the linked value is changed in the original application, the change
is reflected in all linked usages.

Each application allows you to define a value or function as a variable.
Defining a variable is the first step in linking values.

Creating TI-Nspire™ variables
Variables can be any portion or attribute of an object or function created
within an application. Examples of attributes that can become variables
are the area of a rectangle, the radius of a circle, the value contained in a
spreadsheet cell or the contents of a row or column, or a function
expression. When you create a variable, it is stored in memory within the
problem .

Types of variables
You can store the following data types as variables:
Data type

Examples

Expression

2.54

1.25E6

2p

xmin/10

2+3i

(xN2)2

2 /2
List
Matrix

{2, 4, 6, 8}

1 23
3 69

{1, 1, 2}
This can be entered as: [1,2,3;3,6,9]

Character string

“Hello”

Function

myfunc( arg )

Measurement

coordinate, length, perimeter, slope, angle, integral
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“xmin/10”

“The answer is:”

ellipse( x, y, r1, r2 )
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Creating a variable from a Graphs & Geometry value
1.

Click to select the value to store as a variable.

2.

Do one of the following:

3.
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•

Press h. The Variables options are displayed with Store
highlighted.

•

Press / L to display the Variables options. Store is
highlighted.

•

Open the Tools menu and select the Variables option. The
Variables options are displayed with Store highlighted.

Press ·. VAR := appears before the selected value. This is the
default variable name. Type over VAR with the variable name you
want to give the value.
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4.

When the variable name is typed, press ·. The value is saved to
that variable name, and the stored value or its name appears in bold
text to indicate it is a stored value.

Creating a variable from a Lists & Spreadsheet cell value
You can share a cell value with other TI-Nspire™ math and science
learning technology applications. When defining or referring to a shared
cell in Lists & Spreadsheet, you precede the name with an apostrophe (‘).
1.

Click the cell that you want to share.

2.

Press hor / L. A formula is inserted into the cell with var as a
placeholder for a variable name.

3.

Replace the letters “var” with a name for the variable, and press ·.
The value is now available as a variable to other TI-Nspire™ math
and science learning technology applications within the current
problem.

Note: If a variable with the name you specified already exists in the
current problem, Lists & Spreadsheet displays an error message.

Creating Calculator variables
As alternatives to using h, you can use “:=” or the Define command.
All of the following statements are equivalent.
5+8 3

& num

num := 5+8 3
Define num=5+83

Special considerations for variables
Rules for naming variables
Variable and function names that you create must meet the following
naming rules.
Working with Documents
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Note: Avoid defining variables that use the same names as those used
for statistical analysis. In some cases, an error condition could occur.
Variable names used for statistical analysis are listed in the Appendix of
Functions, under the StatMatrix entry.
•

You can use 1 to 16 characters consisting of letters, digits, and the
underscore character (_). Letters can be U.S. or Greek letters (but not
Π or p), accented letters, and international letters.

•

You can use uppercase or lowercase letters. The names AB22, Ab22,
aB22, and ab22 all refer to the same variable.

•

Do not use spaces.

•

If you use an underscore as the first character, the variable it is
considered a type of unit, such as _m, _ft, and _in. Units do not allow
subsequent underscores in the name.

•

You cannot use a preassigned variable or function name, such as ans
or min.
Note: For a complete list of TI-Nspire™ functions, refer to the
TI-Nspire™ Reference Guide.

Here are some examples:
Variable name

Valid?

Myvar

Yes

My var

No. Contains a space.

a

Yes

Log

No. Name is preassigned to the log( ) function.

Log1

Yes

Preventing name conflicts
A TI-Nspire™ shared variable can have the same name as a table cell or
column letter. To help you prevent name conflicts in your table formulas,
Lists & Spreadsheet provides syntax rules.
•
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To refer to a variable whose name could conflict with the name of a
cell (such as A1), precede the variable name with an apostrophe
(‘A1).
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•

To refer to a table column (such as A) without conflicting with a
single-letter variable name A, follow the column letter with a pair of
brackets (A[]).

Use this
syntax:

To refer to:

Remarks

myvar

The shared variable
myvar.

No special syntax needed, because
this name does not conflict with a
cell or column reference.

A1

The table cell at
column A, row 1.

This syntax always refers to table
cell A1—never to variable A1.

‘A1

The shared variable A1. The apostrophe makes this a
reference to variable A1—never to
table cell A1.

A

The shared variable A.

This syntax never refers to column
A.

A[]

Column A of the
current table.

Brackets make this a reference to
column A—never to variable A.

Checking a variable’s value using the Calculator
application
You can check the value of an existing variable by entering its name on
the Calculator entry line.
f

On the Calculator entry line, type the variable name num and press
·.
The value most recently stored in num is displayed as the result.

Using (linking) TI-Nspire™ variables
Sharing, or linking, the variables you create is a powerful tool for math
exploration. The display of linked variables is automatically updated
when the variable’s value changes.
In the following two examples, two data lists were created in Lists &
Spreadsheet and then plotted in Graphs & Geometry.
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When the values are altered in Lists & Spreadsheet, they automatically
update in Graphs & Geometry.

Linking to shared variables
To use a stored variable:
1.

Display the page and select the location or object to which you want
to link a variable.

2.

Do one of the following:
•

Press h. The Variables display.

•

Press / L to display the Variables options.

•

Open the Tools menu and select the Variables option.

3.

Press £ and ¤ to scroll the list, or type part of the variable name. As
you type, the TI-Nspire™ system displays a list of variables that begin
with the letters you typed. Typing part of the name enables you to
locate a variable more quickly if the list is long.
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4.

When you locate and highlight the name of the variable you want to
use, click the name or press ·. The selected variable value is linked.

Linking a Lists & Spreadsheet cell to a variable
When you link a cell to a variable, Lists & Spreadsheet keeps the cell
value updated to reflect the current value of the variable. The variable
can be any variable in the current problem space and can be defined in
Graphs & Geometry, Calculator, or any instance of Lists & Spreadsheet.
Note: Do not link to a system variable. Doing so could prevent the
variable from being updated by the system. System variables include ans,
StatMatrix, and statistics results (such as RegEqn, dfError, and Resid).
1.

Click the cell that you want to link to the variable.

2.

Click

or / L, and click Cell.

The VarLink menu displays.

3.

Under Link To, scroll to the name of the variable and click it.
The cell shows the value of the variable.

Removing a linked variable
To remove a linked variable from a page:
1.

Select the linked variable.

2.

Do one of the following:
•

Press h.
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•

Press / L to display the Variables options.

•

Open the Tools menu and select the Variables option.

The Variables options display.

3.

Select Unlink. The link is removed from the value, and the value is
displayed without any bolding.

Libraries
A library is a TI-Nspire™ document that contains a collection of variables,
functions, and/or programs that have been defined as library objects.
Unlike ordinary variables, functions, and programs, which can be used
only within a single problem (the problem in which they are defined),
library objects are accessible from any document. You can even create
public library objects that appear in the TI-Nspire™ Catalog.
For details, see the “Libraries” chapter in Part 2 of the handheld
guidebook, available on the CD that came with your handheld or on the
Texas Instruments web site, http://education.ti.com.
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Program Editor
The Program Editor helps you define, edit, and manage user-defined
functions and programs.
•

The editor has dialog boxes to help you define functions and
programs using correct syntax.

•

The editor lets you enter multiple-line programming statements
without requiring a special key sequence to add each line.

•

You can easily create private and public library objects (variables,
functions, and programs).

For details, see the “Programming” chapter in Part 2 of the handheld
guidebook, available on the CD that came with your handheld or on the
Texas Instruments web site, http://education.ti.com.

Sending a document to another handheld
You can send documents and Operating System (OS) files to another
TI-Nspire™ handheld.

Rules for sending files
•

If a document with the same name as the one you are sending
already exists on the receiving TI-Nspire™ handheld, the document
will be renamed. The system appends a number to the name to make
it unique. For example, if a document called Mydata existed on the
receiving TI-Nspire™ handheld, it would be renamed Mydata(2).
Both the sending and receiving units display a message that shows
the new name.

•

There is a 255-character maximum length for a file name, including
the entire path. If a transmitted file has the same name as an existing
file on the receiving unit and the file names contain 255 characters,
then the name of the transmitted file will be truncated to allow the
software to follow the renaming scheme described in the previous
bullet.

•

All variables associated with the document being transmitted are
transfered with the document.

•

Transmissions will time out after 30 seconds.

Sending a document
1.

Open My Documents.
Press c 7.
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2.

Press the 5 and 6 keys on the NavPad to highlight the document you
want to send.

3.

Select Send from the My Documents menu.
Press / c 1 5.

4.

The file transfer begins. A progress bar displays to allow you to
follow the transfer. There is a cancel button on the Sending... dialog
that allows you to cancel the transmission while it in progress.
When the transfer is complete, a message displays. If the file was
renamed on the receiving handheld, the new file name displays.

Receiving a document
No action is required by the user of the receiving TI-Nspire™ handheld.
Units are automatically powered on when the cable is attached.

Canceling a transfer
1.

To cancel a transmission in-progress, press Cancel on the dialog of
the sending unit.
Note: To cancel a transfer from the receiving handheld, press d.

2.

A link transmission error message displays.

3.

Press d or · to cancel the transmission error message.
For more information, see the Transferring Files chapter in Part 2 of
this guidebook, available on the CD that came with your handheld,
or on the Texas Instruments web site at
http://education.ti.com/guides.
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Using Calculator
Getting started with the Calculator application
The Calculator application gives you a place to enter and evaluate math
expressions. You can also use it to define variables, functions, and
programs. When you define or edit a variable, function, or program, it
becomes available to any TI-Nspire™ math and science learning
technology application—such as Graphs & Geometry—that resides in the
same problem.
You can also use Calculator to define library objects, such as variables,
functions, and programs, which are accessible from any problem of any
document. For information on creating library objects, see the
“Libraries” section of the documentation.

À

Á

Â

À

Calculator menu – This menu is available anytime you are in the
Calculator work area. Press b to display the menu. The menu in
this screen snapshot may not exactly match the menu on your screen.

Á

Calculator work area
–

You enter a math expression on the entry line and then press
· to evaluate the expression.

–

Expressions display in standard mathematical notation as you
enter them.
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–

Â

Entered expressions and results show in the Calculator history.

Example of Calculator variables used in another TI-Nspire™
application

The Calculator tool menu
The Calculator tool menu lets you enter and evaluate a variety of math
expressions.
Menu
Name

Menu Option

Function

Actions

Define

Inserts the Define command.

Recall Definition

Lets you view, reuse, or modify
a function or program that you
have defined.

Delete Variable

Inserts the delVar command.

Clear a-z

Deletes all variables with
single-letter names.

Clear History

Deletes all expressions in the
Calculator history.

Insert Comment

Lets you insert text.

Library

Lets you refresh all libraries, set
LibPub or LibPriv access, or
insert a “\” character

Number
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Convert to Decimal

Inserts ¢Decimal command.

Factor

Inserts factor().

Least Common Multiple

Inserts lcm().

Greatest Common Divisor

Inserts gcd() function.

Remainder

Inserts remain().

Fraction Tools

Lets you select propFrac(),
getNum(), getDenom().
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Menu
Name

Menu Option

Function

Number Tools

Lets you select round(), iPart(),
fPart(), sign(), mod(), floor(),
or ceiling().

Complex

Complex Conjugate

Inserts conj().

Real Part

Inserts real().

Imaginary Part

Inserts imag().

Polar Angle

Inserts angle().

Magnitude

Inserts the absolute value
template.

Convert to Polar

Inserts ¢Polar command.

Convert to Rectangular

Inserts ¢Rect command.

Calculations
Numerical Solve

Inserts nSolve().

Numerical Function
Minimum

Inserts nfMin().

Numerical Function
Maximum

Inserts nfMax().

Numerical Derivative

Inserts nDeriv().

Numerical Integral

Inserts nInt().

Finance Solver

Starts the Finance Solver.

Probability

Factorial (!)

Inserts !.

Permutations

Inserts nPr().

Combinations

Inserts nCr().

Random

Lets you select rand(),
randInt(), randBin(),
randNorm(), randSamp(), or
RandSeed.
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Menu
Name

Menu Option

Function

Distributions

Lets you select from several
distributions, such as Normal
Pdf, Binomial Cdf, and
Inverse F.

Statistics

Stat Calculations

Lets you select from several
statistics calculations, such as
one-variable analysis, twovariable analysis, and
regressions.

Stat Results

Inserts the stat.results variable.

List Math

Lets you select from several list
calculations, such as minimum,
maximum, and mean.

List Operations

Lets you select from several list
operations, such as sorting,
filling, and converting to a
matrix.

Distributions

Lets you select from several
distributions, such as Normal
Pdf, Binomial Cdf, and
Inverse F.

Confidence Intervals

Lets you select from several
confidence intervals, such as
t interval and z interval.

Stat Tests

Lets you select from several
tests such as ANOVA, t test, z
test.

Matrix & Vector
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Transpose

Inserts T

Determinant

Inserts det().

Row-Echelon Form

Inserts ref().
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Menu
Name

Menu Option

Function

Reduced Row-Echelon
Form

Inserts rref().

Simultaneous

Inserts simult().

Create

Lets you select from several
matrix-creation options, such as
identity, diagonal, submatrix,
and others.

Norms

Lets you select norm(),
rowNorm(), or colNorm().

Dimensions

Lets you select dim(),
rowDim(), or colDim().

Row Operations

Lets you select rowSwap(),
rowAdd(), mRow(), or
mRowAdd().

Element Operations

Inserts “dot” operators such as
.+ (dot add) and .^ (dot power).

Advanced

Inserts eigVl(), eigVc(), LU, or
QR.

Vector

Inserts unitV(), crossP(), dotP(),
8Polar, 8Rect ,8Cylind, or
8Sphere.

Functions & Programs

Program Editor

Lets you view, open for editing,
import, or create a new program
or function.

Func...EndFunc

Inserts a template for creating a
function.

Prgm...EndPrgm

Inserts a template for creating a
program.

Local

Inserts the Local command.
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Menu
Name

Menu Option

Function

Control

Lets you select from a list of
function and program-control
templates, such as
If...Then...EndIf,
While...EndWhile,
Try...Else...EndTry, and others.

Transfer

Inserts transfer commands
Return, Cycle, Exit, Lbl, Stop,
or Goto.

Disp

Displays intermediate results.

Mode

Inserts commands for setting or
reading modes, such as display
digits, angle mode, base mode,
and others.

Add New Line

Starts a new line within a
function or program definition.

Before you begin
f

Turn on the handheld, and add a Calculator application to a
document.

Entering and evaluating math expressions
Options for entering expressions
Calculator lets you enter and edit expressions through several methods.
•

By pressing keys on the handheld keypad

•

By selecting items from the Calculator menu

•

By selecting items from the Catalog (k)

Entering simple math expressions
Note: To enter a negative number on the handheld, press v. To enter a
negative number on a computer keyboard, press the hyphen key (-).
Suppose you want to evaluate
1.

60

Select the entry line in the Calculator work area.

Using Calculator

2.

Type 2^8 to begin the expression.

3.

Press ¢ to return the cursor to the baseline, and then type

r 43 p 12.

4.

Press · to evaluate the expression.
The expression displays in standard mathematical notation, and the
result displays on the right side of the Calculator.

Note: If a result does not fit on the same line with the expression, it
displays on the next line.

Controlling the form of a result
You might expect to see a decimal result instead of 2752/3 in the
preceding example. A close decimal equivalent is 917.33333..., but that’s
only an approximation.
By default, Calculator retains the more precise form: 2752/3. Any result
that is not a whole number displays in a fractional form. This reduces
rounding errors that could be introduced by intermediate results in
chained calculations.
You can force a decimal approximation in a result:
•

By pressing / · instead of · to evaluate the expression.

Pressing / · forces approximate result.
•

By including a decimal in the expression (for example, 43. instead of
43).
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•

By wrapping the expression in the approx() function.

•

By changing the document’s Auto or Approximate mode setting to
Approximate. (Press / c 1 to display the File menu, and then
select Document Settings.) Note that this method forces all results
in all of the document’s problems to approximate.

Inserting items from the Catalog
You can use the Catalog to insert system functions and commands,
symbols, and expression templates into the Calculator entry line.
1.

Press k to open the Catalog.

Note: Some functions have a wizard that prompts you for each
argument. If you prefer to enter the argument values directly on the
entry line, you may need to disable the wizard.
2.

Press the number key for the category of the item. For example,
press 1 to show the alphabetic list.

shows an alphabetic list of functions and commands.
shows math functions and commands by category.
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provides a symbol palette for adding special characters.
contains math templates for creating two dimensional
objects, including product, sum, square root and integral.
shows Public library (LibPub) objects.

3.

Press ¤ and then use ¡, ¢, £, or ¤ as necessary to select the item
that you want to insert.
Note: To see syntax examples of the selected item, press e, and
then press · to alternately show or hide the Help. To move back to
the selected item, press g e.

4.

Press · to insert the item into the entry line.

Using an expression template
The Calculator has templates for entering matrices, piecewise functions,
derivatives, products, and other math expressions.

For example, suppose you want to evaluate

1.

Press / r to open the Template palette.

2.

Select

to insert the algebraic sum template.

The template appears on the entry line with small blocks
representing elements that you can enter. A cursor appears next to
one of the elements to show that you can type a value for that
element.

3.

Use the arrow keys to move the cursor to each element’s position,
and type a value or expression for each element.
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4.

Press · to evaluate the expression.

Editing Calculator expressions
Although you cannot edit an expression in the Calculator history, you can
copy all or part of an expression from the history and paste it to the entry
line. You can then edit the entry line.

Positioning the cursor in an expression
f

Press e to cycle through the parameters of a template.
– or –
Press ¡, ¢, £, or ¤ to move the cursor through the expression. The
cursor moves to the closest valid position in the direction that you
press.

Note: An expression template may force the cursor to move through its
parameters, even though some parameters may not be exactly in the
path of the cursor movement. For example, moving upward from the
main argument of an integral always moves the cursor to the top limit.

Inserting into an expression in the entry line
1.

Position the cursor at the point where you want to insert additional
elements.

2.

Type the elements that you want to insert.

Note: When you insert an open parenthesis, Calculator adds a temporary
close parenthesis, displayed in gray. You can override the temporary
parenthesis by typing the same parenthesis manually or by entering
something past the temporary parenthesis (thereby implicitly validating
its position in the expression). After you override the temporary gray
parenthesis, it is replaced with a black parenthesis.
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Selecting part of an expression
1.

Press ¡, ¢, £, or ¤ to move the cursor to a starting point.

2.

Press and hold g and press ¡, ¢, £, or ¤ to select.

Deleting all or part of an expression on the entry line
1.

Select the part of the expression to delete.

2.

Press ..

Working with the Calculator history
As you enter and evaluate expressions in the Calculator application, each
entry/result pair is saved in the Calculator history. The history gives you a
way to review your calculations, repeat a set of calculations, and copy
expressions for reuse in other pages or documents.

Viewing the Calculator history
The history of the expressions you have entered accumulates above the
entry line, with the most recent expression at the bottom. If the history
does not fit in the Calculator work area, you can scroll through the
history.
Note: You may notice a processing slowdown when the history contains
a large number of entries.
f

Press £ or ¤.

À

Á

À
À

Scrollbar buttons
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Á

Scroll position indicator

Reusing a previous expression or result
You can copy an expression, subexpression, or result from the Calculator
history and paste it into the entry line or into other TI-Nspire™
applications.
1.

Scroll to the item that you want to copy.

2.

Select the item.

Note: The float setting for the current document may limit the
number of decimal places displayed in a result. To capture the result
in its full precision, select it either by scrolling with the up and down
arrow keys or by triple-clicking it.
3.

Press / C to make the copy.

4.

Select the location where you want the copy.

5.

Press / V to paste the copy.

Note: If you copy an expression that uses variables into a different
problem, the values of those variables are not copied. You must define
the variables in the problem where you paste the expression.

Deleting an expression from the history
When you delete an expression, all variables and functions defined in the
expression retain their current values.
1.

Use the arrow keys to select the expression that you want to delete.

2.

Press ..
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The expression and its result are removed.

Clearing the Calculator history
When you clear the history, all variables and functions defined in the
history retain their current values. If you clear the history by mistake, use
the undo feature.
1.

Press b to display the Calculator menu.

2.

On the Actions menu, select Clear History.
All expressions and results are removed from the history.

Where to find more information
More in-depth information, step-by-step instructions, and screen
examples of all the Calculator features are contained in the Using
Calculator chapter in Part 2 of the user guide, which is available on the
CD-ROM that came with your handheld and as a download from the web
site: http://education.ti.com/guides.
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Using Graphs & Geometry
The Graphs & Geometry application enables you to:
•

Graph and explore functions.

•

Create and explore geometric shapes.

•

Animate points on objects or graphs and explore their behavior.

•

Graph data collected by the Data Collection tool.

•

Explore graphical and geometric transformations.

•

Explore and investigate concepts of calculus.

•

Link to data created by other applications and utilize it in Graphs &
Geometry.

À
Á

Â
À
Á

Problem/Page number counter

Â

Graphs & Geometry data entry line

Sample Graphs & Geometry work area in Plane Geometry View with
Analytic Window shown

These are the basic components of the Graphs & Geometry application.

The toolbar
To quickly access a tool menu, use the numeric quick keys.
Note: The number that precedes each title is the numeric entry for
accessing the tool using the handheld keys or the virtual keypad on the
computer. For example, to draw a circle, you would press b 8 1.
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Menu Option List

Overview of Tool Actions

Press:

1: Actions

Provides tools to access the
pointer, hide or show various
graph features, add text, delete all
objects in the work area, open the
calculator, and access attributes
for an object or function.

b1

2: View

Provides tools to manipulate the
work area features and display.

b2

3: Graph Type

Enables you to select the type of
graph to plot: function,
parametric, or scatter plot.

b3

4: Window

Provides different Zoom settings
as well as the ability to define xmax, x-min, y-max, and y-min.

b4

5: Trace

Places and enables the trace tool
on the graph.

b5

6: Points & Lines

Provides tools for drawing various
types of points, lines, segments,
rays, and vectors.

b6

7: Measurement

Provides tools for measuring
angles, lengths, areas, and slope.

b7

8: Shapes

Provides tools for drawing circles,
triangles, rectangles, and
polygons.

b8

9: Construction

Provides tools to define
perpendicular and parallel lines,
bisectors, midpoints, locus,
compass, and perform
measurement transfers.

b9

A: Transformation Provides tools for symmetry,
reflection, translation, rotation,
and dilation.
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Actions Menu Tools
Tool name

Tool function

Press:

1: Pointer

Selects, moves, and manipulates
objects.

b11

2: Hide/Show

Enables you to hide or display any
object, function, or feature on the
work area.

b12

3: Attributes

Enables you to change the
attributes of a selected object in
the work area. Attributes vary
depending upon the object
selected.

b13

4: Delete All

Removes all objects and graphed
functions from the page.

b14

5: Text

Places user-created alpha-numeric
values on the page. Numerical
values can be applied to objects.
The tool can be used to enter a
function and graph it.

b15

6: Coordinates and Displays the coordinates of a
Equations
point or the equation of a line or
circle.

b16

7: Calculate

Opens the calculator to perform
calculations using measurements,
numerical values, or calculation
results.

b17

8: Redefine

Redefines a previously defined
point to a new location; for
example, it can define a point in
free space to a location on an
object or from one object to
another object.

b18

9: Data Collection Adds the Data Collection tool to
the current Graphs & Geometry
page. See the Data Collection
chapter for details on using this
tool.

b19
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View Menu Tools
Tool name

Tool function

1: Graphing

Places the work area in graphing mode. Axes fill
the work area, and the entry lines displays at the
bottom of the screen. This is the default display
when Graphs & Geometry is added to a page.

2: Plane
Geometry

Places the work area in geometry mode. Show
scale displays, but no axes, grid, or entry line
displays.

3: Show
Analytic
Window

Opens a small graphing window on a plane
geometry work area. Places the Graphs &
Geometry work area in modeling mode. This
tool can be used only after Plane Geometry is
selected.

4: Hide (Show)
Axes

Hides the axes if they are currently displayed on
the page. Displays the axes if none are displayed
on the page. Cartesian axes are the supported
axes.

5: Show (Hide)
Grid

Turns the grid on or off on the page. Objects can
be attached to the grid when the grid is
displayed.

6: Hide (Show)
Entry Line

Hides or displays the entry line on the page.

7: Show (Hide)
Scale

Toggles between showing and hiding the scale
legend on the work area. When the scale is
shown, the value and/or units can be changed to
desired values/units. This applies only to
geometric constructions.

8: Add Function Launches the Lists & Spreadsheet function table.
Table
When launched from Graphs & Geometry, it is
pre-populated with all functions defined in the
problem with the exception of hidden functions.
More information on using Function Tables is
available in the Lists & Spreadsheet chapter of
this document.
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Graphing Type Menu Tools
Tool name

Tool function

Press:

1: Function

Displays the function mode entry
line at the bottom of the work
area.

b31

2: Parametric

Displays the parametric mode
entry line at the bottom of the
work area. This display shows the
t-min, t-max, and t-step values.
The defaults are 0-2p for t-min, tmax, and p/24 for t-step.

b32

3: Polar

Displays the Polar mode entry
line at the bottom of the work
area. This display shows the qmin, q-max, and q-step values.
The defaults are 0-2p for q-min
and q-max, and p/24 for q-step.

b33

4: Scatter Plot

Displays the Scatter Plot mode
entry line at the bottom of the
work area.

b34

Tool name

Tool function

Press:

1: Window
Settings

Displays the Window Settings
dialog that enables you to enter
the x-min, x-max, y-min, and y-max
values for the axes.

b41

2: Zoom - Box

Enables you to define an area that
you want to enlarge.

b42

3: Zoom - In

Enables you to define the center
point of the zoom in location. The
Zoom In factor is approximately 2.

b43

4: Zoom - Out

Enables you to define the center
point of the zoom out location.
The Zoom Out factor is
approximately 2.

b44

Window Menu Tools
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Tool name

Tool function

Press:

6: Zoom Quadrant 1

Automatically sets x-min, x-max, ymin, and y-max to emphasize the
first quadrant. The x and y scale
factors are equal.

b45

5: Zoom Standard

Automatically sets x-min, x-max, ymin, and y-max to center the
origin. The x and y scale factors are
equal. This is the default axes
setting when Graphs & Geometry
is first added to a page.

b46

7: Zoom - User

If you have modified any window
settings (such as x-min), ZoomUser saves the present settings. If
you have not modified any
window settings since last
selecting Zoom-User, Zoom-User
restores those settings.

b47

8: Zoom - Trig

Automatically sets x-min and xmax to integer multiples of p. The
x and y scale factors are equal.

b48

9: Zoom - Data

Redefines the axes so that all
statistical data points are
displayed.

b49

A: Zoom - Fit

Recalculates y-min and y-max to
include the minimum and
maximum y values of all functions
between the current x-min and xmax. Hidden functions are not
included.

b4A

Trace Menu Tools
Tool name
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Tool function

1: Graph Trace

Places and activates a trace point on the graph,
enabling you to trace a function and identify
points of interest as they are encountered
during the trace.

2: Trace Setting

Enables you to set the increment to use
between consecutive values jumped to during
Graph Trace.
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Tool name

Tool function

3: Geometry Trace

Enables you to view the pathway of a
geometric or analytic object (such as a function
graph) on the work area. The pathway has a
delayed fade. As more movement occurs on
the work area, older portions of the pathway
fade. If you temporarily halt movement, a
portion of the trace path remains displayed.

4: Erase Geometry
Trace

Halts geometric trace and erases all persistent
pathways on the work area.

Points and Lines Menu Tools
Tool name

Tool function

Press:

1: Point

Constructs a point defined in free
space, on an object, or at the
intersection of two objects.

b61

2: Point On

Constructs a point defined on an
object. When the object is a function
graph, the coordinates are displayed.

b62

3: Intersection Constructs a point at each
Point
intersection of two selected objects.

b63

4: Line

Constructs an infinite line defined by
two points or by a point and a
direction. If you press g while
creating the line, you limit its
orientation, relative to the x-axis or
the horizontal aspect of the screen,
by 15- increments.

b64

5: Segment

Constructs a segment, defined by
two end points, which may be
created or defined in free space or
on a defined object. If you press g
while creating the segment, you limit
its orientation, relative to the x-axis
or the horizontal aspect of the
screen, by 15- increments.

b65
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Tool name

Tool function

Press:

6: Ray

Constructs a ray, defined by two
points or by a point and a direction,
extending infinitely. If you press g
while creating the ray, you limit its
orientation, relative to the x-axis or
the horizontal aspect of the screen,
by 15- increments.

b66

7: Tangent

Creates a tangent line.

b67

8: Vector

Constructs a vector with magnitude
and direction defined by two points.
If you press g while creating the
vector, you limit its orientation,
relative to the x-axis or the
horizontal aspect of the screen, by
15- increments.

b68

Measurements Menu Tools
Tool name
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Tool function

Press:

1: Length

Displays the distance between two
selected points or the length of a
segment, perimeter, circumference,
or radius.

b71

2: Area

Displays the area of a selected
polygon or circle.

b72

3: Slope

Displays the slope of a selected line
or segment. A vertical slope is
represented by %.

b73

4: Angle

Displays the measure of an angle or
an angle defined by three selected
points.

b74

5: Integral

Calculates and displays the
numerical value of the integral of a
selected function, and shades the
area between the curve and the
x-axis from point a to point b.

b75
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Shapes Menu Tools
Tool name

Tool function

Press:

1: Circle

Constructs a circle. The center point
is defined by the first click on the
page and the radius is determined
by the second click.

b81

2: Triangle

Constructs a triangle, defined by
three points (vertices).

b82

3: Rectangle

Constructs a rectangle. Click once
to define one corner. Move then
click to define one side. Move
perpendicularly to draw the
rectangle. Click to complete it.

b83

4: Polygon

Constructs an n-sided polygon. Each
click defines a vertex. The polygon
is completed by clicking the initial
vertex, or by pressing ·.

b84

5: Regular
Polygon

Constructs an n-sided regular
polygon. Click to define the center
and click again to define the radius.
Move clockwise (convex) or
counter-clockwise (star) to set the
value of n.

b85

Constructions Menu Tools
Tool name

Tool function

Press:

1: Perpendicular

Constructs a line perpendicular
to a selected line, segment, ray,
vector, axis, or side of a polygon,
and passing through a created
or selected point.

b91

2: Parallel

Constructs a line parallel to a
selected line, segment, ray,
vector, axis, or side of a polygon,
and passing through a created
or selected point.

b92

3: Perpendicular
Bisector

Constructs a perpendicular line
that bisects two points, a
segment, or side of a polygon.

b93
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Tool name

Tool function

Press:

4: Angle Bisector

Constructs a line that bisects an
angle identified by three
selected points where the
second point is the vertex.

b94

5: Midpoint

Constructs a midpoint of two
selected points, a segment, or
side of a polygon.

b95

6: Locus

Constructs the locus of a point
or object defined by the
movement of a driver point
along a pathway. Pathways are
geometric objects.

b96

7: Compass

Constructs a circle from a center
point with a radius defined by a
selected segment or the distance
between two points.

b97

8: Measurement
Transfer

Transfers an entered or
measured value to a selected
object, axis, or function graph. If
the original value changes, the
change is reflected in the
transferred measurement.

b98

Transformations Menu Tools
Tool name
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Tool function

Press:

1: Symmetry

Creates the image of an object
rotated 180- around a point.

bA1

2: Reflection

Creates the image of an object
reflected across a line, segment,
ray, vector, axis, or side of a
polygon.

bA2

3: Translation

Creates the image of an object
translated by a specified vector.

bA3

4: Rotation

Creates the image of an object
rotated around a point by a
specified angular value.

bA4

Using Graphs & Geometry

Tool name
5: Dilation

Tool function
Creates the image of an object
dilated from a point by a
specified factor.

Press:

bA5

Note: When you select a tool to use, that tool’s icon displays in the upper
left corner of the Graphs & Geometry page. It is there to remind you
which tool is currently active.

The work area
Graphs & Geometry provides two types of work areas:
•

Graphing

•

Plane Geometry

The graphing view
The graphing view is the default Graphs & Geometry work area display. It
contains
•

coordinate axes in the Zoom Standard format (1:1 scale)

•

the entry line from which you can graph up to 100 functions.

Axes, entry line, and grid can all be displayed or hidden, but in this view,
no scale for any drawn shapes (e.g. Circle, etc.) can be displayed. All
objects created in this view are analytic objects. Therefore, their
displayed size and proportion are affected only by the scale of the axis
system (the command "Show Scale" has no effect).

The plane geometry view
The plane geometry view removes the axes and entry line from the work
area to enable you to draw geometric shapes and explore them. In this
view, you can display and set a scale for your drawings.
To change to Plane Geometry view:
1.

From the View menu, select the Plane Geometry View tool.
Press b 2 2.

2.

The display refreshes to clear the axes and entry line and display a
default scale. Any graphs or drawings created in graphing view are
not displayed on the plane geometry area.

To return to graphing mode:
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f

From the View Menu, select the Graphing View tool.
Press b 2 1.
The display refreshes to show the axes and entry line.
Note: Any geometric constructions created while in the plane
geometry view are retained and displayed along with any previouslycreated graphs.

The analytic window
The analytic (graphing) window is available in the plane geometry view.
It adds an analytic (graphing) window on top of a portion of the plane
geometry work area. This provides a combination work area that enables
you to use both work area types without toggling the view between
them.
To open the analytic window:
1.

Ensure that the work area is in Plane Geometry view.

2.

From the View menu, select Show Analytic Window
Press b 2 3.

3.

A reduced size graphing window opens on the lower left corner of
the plane geometry space.

.

You can alter the work area, without changing the view, to temporarily:
•

hide the axes. Any graphs or objects remain displayed on the
work area.

•

hide the entry line.

•

hide the scale.

•

resize the axes using the zoom tools or by dragging tic marks.

To remove the analytic window from the work area
f
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From the View menu, select Hide Analytic Window
Press b 2 3.

.
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Object behavior in different views
When you create an object in the graph area, it is called an analytic
object, and all points of the object reside on the graph plane. When you
change the axes scale, you automatically affect the appearance of the
object. If you calculate a value associated with the object such as the
area, only generic units are assigned (u for unit). These objects remain
associated with the coordinate plane until you delete them or redefine
them to the plane geometry area. When working with a modeling view
work area, you cannot move an analytic object onto the plane geometry
area.
When you create an object in the plane geometry area, it is a geometric
object. These objects can have an assigned scale, such as miles or
centimeters, instead of u for units. You can lock a point, such as one
vertex of a triangle, on the work area, but since the object is not tied to a
coordinate plane, you cannot display coordinates for that vertex. When
working with a modeling view work area, you can move a geometric
object into the graphing work area. The object remains a geometric
object, and is not associated with the axes.

Summary of differences
Feature

Graph Area

Plane Geometry Area

Aspect Ratio

Adjustable; initially 1:1

Always 1:1 (static)

Units of Measure

Generic (displayed as u)

User-defined (per scale)

Area Graph Type

Cartesian (default) or
Polar

Euclidian
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Feature

Graph Area

Plane Geometry Area

Uses

• Define and graph
functions to:

• Construct Euclidean
objects

–

Graph
functions of
the form f (x)

–

Create scatter
plots

–

Graph polar
equations

–

Graph
parametric
functions

• Create
transformations
• Determine
measurements (e.g.,
length, angle, area)

• Construct analytic
objects
• Label equations
• Identify coordinates
for discrete points
Behavior

Analytic constructions
must remain in the
analytic area.

Geometric
constructions can be
moved into the analytic
area but remain
geometric in nature.

Creating and manipulating axes
When the Graphs & Geometry application is first added to a page, a set
of Cartesian axes displays by default.
You can change the appearance of your axes in the following ways:
1.

Adjust the length of the axes:
•

When using Plane Geometry mode with Show Analytic Window,
–

Select an axis and retype the domain or range labels.

–

Select an axis and drag to increase or decrease the numbers
on the scale and tic mark spacing.

The aspect ratio of the axes is retained. To modify the scale of only
one axis, press the Shift key as you adjust the value or drag the line.
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Default range and
domain

Extended domain

2.

Use the Zoom tool options to adjust the view.

3.

Adjust the end style of the axes using the Attributes tool. Display the
Attributes tool by:
•

selecting it from the menu

or
•

pressing / b on an axis between two tick marks.

Press the left and right arrow keys to display the desired end style.
The attributes list for the axes also enables you to select a Zoom
option.
4.

Adjust the axes scale and tic mark spacing manually.
a)

Click and hold one tic mark, and move it on the axis. The
spacing and number of tic marks increases (or decreases) on
both axes.

b)

To adjust the scale and tic mark spacing on a single axis,
press and holdg, and then grab and drag a tic mark on
that axis.
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5.

Adjust the location of the axes. To move the existing axes without
resizing or rescaling them, click in and drag an empty region of the
screen until the axes are in the desired location.

Use the Window Setting tool (
) to define the x-max, x-min, y-max, ymin, and trace step values for the axes. When selected, this tool opens a
dialog that enables you to enter the values desired. The current values
are initially displayed. Type over them to enter new values.

Window Settings dialog with initial values displayed

You can hide and redisplay axes using the Hide/Show Axes tool.
f

From the View menu, select the Hide/Show Axes tool (

).

Press b 2 4.
•

If the axes are shown on the page, selecting this tool hides them.

If the axes are hidden on the page, selecting this tool redisplays them.

Drawing a circle
The following instructions enable you to construct a circle. While each
tool is a little different depending upon the type of object created, the
principles of using the tools to draw objects are very similar. You can
obtain additional information, instructions, and see examples of objects
in the Graphs & Geometry chapter of the User Guide.
1.

Open Graphs & Geometry on a page.
Press b 8 1. Move to the work area.

2.
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Click on the screen to define the center point of the circle.
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Move the cursor away from this point. A circle with a dotted
circumference line emerges as you move the cursor.

3.

When the circle has the radius you desire, click again.
The dotted circumference changes to a solid circumference in the
work area.

Note: If you hold down the g key when creating the circle, the radius
is limited in length to integers.

The entry line
The Entry line appears at the bottom of the Graphs & Geometry work
area.

ÀÁ Â Ã

Ä

When the line is not active, it is grayed out. From left to right, the parts
of this line are:

À Hide/Show function button.
Á Attributes button.
Â f1(x)= is the default notation used for a function or inequality.
Ã Blank area into which you enter the function, polar equation,
inequality, parametric, or scatter plot data to be graphed.

Ä Expand/Contract (History) button.

Parametric Mode entry line. The default values for t-min, t-max, and t-step
are shown.

Scatter Plot Mode entry line
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Polar Mode entry line

Using the entry line
To enter a function on the entry line:
1.

Select the mode.

2.

Type the function you want to graph in the space at the right of the
= sign.

3.

Press · or e.

You can enter and graph a maximum of 99 functions on the screen (f1(x)
- f99(x) ) in addition to any user-named functions such as g1(x). You can
review the functions entered on a page by pressing the Expand button.
Use 9 and : to move up and down the list.
You can also graph functions by typing them into a text box.
f

Select the Text tool (
), and type the function you want to graph
into the box displayed when you move the curson onto the page.

f

Drag the text box to the x-axis, and drop it on the axis to graph the
function.

Regardless of how you enter functions, each function is labeled on the
graph for identification.

Graphing inequalities
Function mode enables you to define a function that uses a symbol other
than the equal sign. To change = to a different sign and graph the
inequality:
1.

Position the cursor to the right of the equal sign.
Press. to delete the equal sign.

2.
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Type the desired sign or use the Symbol Palette to enter the
appropriate inequality. The possible inequalities are: >, +, {, and |.
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3.

Type the rest of the inequality expression.
Press· to graph it.
The expression, as typed, displays next to the graph. Shading is
always present on the graphs of inequalities to show the values that
satisfy the inequality. If you graph two inequalities that overlap, the
area of overlap is shaded darker than either of the individual
inequality graphs.

Finding points of interest: zeroes, minima, maxima
When you create a graph, you can use the Point On tool (
) (press
b 6 2) to locate the zeros, minima, and maxima if these are
applicable for objects on the work area. (They may not display if their
location on the graph not visible on your screen.) Both local and global
points of interest display.
Note: Global points of interest display only when they are also local. For
example, inverse sine reaches its (global) maximum at x=1, but the
tooltip 'M' does not display there since it is not a local maximum.
To find them, just move the point along the object or graphed line, and
when you are near a point of interest, the coordinates display along with
one of the following identifiers:
•

Zeroes: z ( Coordinates )

•

Minimum: m ( Coordinates )

•

Maximum: M ( Coordinates )
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Animating objects
You can animate a point on a line, ray, axis, vector, graph, segment or
circle. In addition, you can also animate points on multiple objects in the
work area at one time.

Animating one point on an object
1.

From the Points & Lines menu, select the tool (

). Press b 6

2.
Click on the object to identify the point you want to animate.

2.

From the Actions menu, select the Attributes tool (

).

Press b 1 3.
When the attribute bar displays, select the animation attribute (
3.

).

The default speed is 0. You can type a number from 1 - 9 to set speed
or you can use < or > to select a speed from -12 to 12.
The higher the number you type, the faster the animation speed.

4.

Select → for one-way animation or ↔ for oscillating animation.

5.

Animation begins automatically when you select the speed and
direction.
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Press + and - to increase/decrease the speed of animation
incrementally once it is set.

The animation control panel
Once a point is animated, a floating control panel displays on the page.
You can move this panel by dragging it to a new location.
When animation is active, the panel contains a Reset
and a Pause
button. When either button is pressed, and animation is reset or paused,
the Pause button changes to a Start
button. These controls are affect
all animated points on a page.

Panel when animation is
active

Panel with animation
paused/reset

Resetting animation
Selecting the Reset
button not only pauses animation but also returns
the animated point to its initial coordinate position on the object when
animation was first started. If multiple points are animated on the page,
all are returned to their original locations when you select Reset.

Stopping animation
To stop the animation of an object:
1.

Select the Pause

or Reset

button on the control bar.

2.

Display the Animation attribute for the point.

3.

Change the speed to 0 (zero).

4.

Click an empty area of the screen to apply the change, or press ·.

5.

Select Start
to resume animation if other animated points were
temporarily stopped.
If no other animated points are on the page, the animation control
box does not reappear when the velocity is set to 0.
Note: If you have multiple points in motion on one page and want
to permanently stop the animation of all objects, when motion is
paused or stopped, display the attributes bar for each point and
change the velocity to 0.
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Creating a Scatter Plot
If you do not have an existing set of data points available for plotting,
create them on the same page using the Lists & Spreadsheet application.
1.

To create the data lists and scatter plot on the same page, select a
page configuration with two work areas.

2.

Create the data lists on the Lists & Spreadsheet portion of the page.

3.

Select the Scatter Plot tool (

)

Press b 3 3.

4.

Select the lists to plot from the drop down list for each axis.

5.

When both entry fields have a data list specified, the scatter plot
displays on the Graphs & Geometry work area.
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More Information
More in-depth information, step-by-step instructions, and examples of all
the Graphs & Geometry features are contained in the Graphs & Geometry
chapter in Part 2 of the user guide, available on the CD that came with
your handheld, or on the web site at http://education.ti.com/guides.
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Using Lists & Spreadsheet
Getting started with tables
The Lists & Spreadsheet application gives you a place to work with
tabular data. You can use Lists & Spreadsheet to:
•

Store numeric data, text, or math expressions.

•

Define a table cell in terms of the contents of other cells.

•

Define an entire column in terms of another column.

•

Work with variables created in the Graphs & Geometry and
Calculator applications.

•

Collect tables of real-world data from sensors.

•

Generate columns of data based on other columns or sequences that
you define.

•

Share individual cells with other TI-Nspire™ math and science
learning technology applications as variables, and share columns of
data as lists.

•

Plot table data using the Data & Statistics application.

•

Generate function tables from functions defined in Calculator or
Graphs & Geometry.

•

Perform statistical analysis on lists of data.
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À

Á

Â

À

Lists & Spreadsheet menu (available when a Lists & Spreadsheet work
area is active) Press b to display the menu.

Á
Â

Sample Lists & Spreadsheet work area
Lists & Spreadsheet data shared with another TI-Nspire™ application

The Lists & Spreadsheet tool menu
The Lists & Spreadsheet tool menu lets you modify your display and enter
and evaluate a variety of math expressions.
Menu
Name

Menu Option

Function

Actions
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Move Column

Lets you reposition the current
column.

Resize

Lets you set a column to the
maximum or minimum width.
You can set a custom row
height or column width by
positioning the column edge at
the size you want and clicking
with the NavPad.
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Menu
Name

Menu Option

Function

Select

Selects an entire row or
column, or helps you insert a
range of cells into a cell
formula.

Go To (/ G)

Jumps to the specified cell, such
as d16 or g20.

Recalculate (/ R)

Recalculates results of all cell
formulas.

Sort

Lets you sort the selected
columns of the spreadsheet
based on the contents of a
single column.

Insert
Insert Cell

Inserts a cell.

Insert Row

Inserts a row above the current
row.

Insert Column

Inserts a column before the
current column.

Generate Sequence

Displays a dialog box for
creating a sequence.

Data Capture

Allows manual or automatic
capture of variable data from
Graphs & Geometry, Calculator,
or within Lists & Spreadsheet.
Use / ^ to trigger each
manual capture.

Fill Down

Lets you duplicate the contents
of a selected cell or group of
cells within a column.

Data
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Menu
Name

Menu Option

Function

Quick Graph

Uses the Data & Statistics
application to graph one or
two selected columns of data as
a dot plot or scatter plot.

Statistics

Stat Calculations

Lets you select from several
statistics calculations, such as
one-variable analysis, twovariable analysis, and
regressions.

Distributions

Lets you calculate and plot
several distributions, such as
Normal Pdf, Binomial Cdf, and
Inverse F.

Confidence Intervals

Lets you calculate several
confidence intervals, such as
t interval and z interval.

Stat Tests

Lets you perform and plot
several hypothesis tests such as
t test, z test, and ANOVA.

Function Table
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Switch to Function Table
(/ T)

Toggles the function table
view.

Select Function

Lets you select a different
function for the current
column.

Edit Function Table
Settings

Lets you change the viewing
parameters for the table.

Delete Column

Removes the current column.

Edit Function Expression

Lets you change a function
definition without leaving the
function table.
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Navigating in a spreadsheet
You can select any cell to view or edit its contents. When a spreadsheet is
larger than the Lists & Spreadsheet work area, you can view different
parts of the spreadsheet by:
•

Pressing ¡, ¢, £, and ¤ to move through the spreadsheet. This
moves the selection from cell to cell and scrolls as necessary to keep
the selected cell in view.

•

Using the Go To command on the Actions menu to select a specific
cell. Type the cell’s column letter and row number (such as G16).

A column letter appears at the top of each column, and a row number
appears in the left cell of each row. The top two rows and the left column
of the spreadsheet remain in place as you scroll so you can more easily
determine your location.

À

Ã

Á

Ä

Â
À
Á
Â
Ã
Ä

Column reference
Header or formula row
Row reference
Column/list name
Cells

Methods of entering table data
The method you use to enter spreadsheet data depends on the type of
data and your personal preferences. You can use different methods in
combination.
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•

For numbers, text, and simple math expressions and formulas such as
=a3¦length2, press the corresponding keys on the handheld keypad.
In this example, press = A 3 r L E N G T H q.
5

•

For more complex math expressions such as

1

∑ --n- press k to
n=1

display the complete Catalog of system functions and commands,
symbols, and expression templates.
•

To display only the list of templates, press / r.

•

To display only the list of symbols, press / k.

Working with individual cells
Creating absolute and relative cell references
Cell references let you enter formulas that refer to spreadsheet data
instead of having to duplicate it and remember to update it. When you
change the contents of a referenced cell, all references to the data are
updated automatically in the table.
Anytime you want to update all references and formula results in the
table, you can select Recalculate from the Actions menu (or press
/ R).
Cell formulas begin with the = symbol. You refer to a cell by using its
column letter and row number. Entering =3*C4 as a formula, for
example, creates an expression that is 3 * the contents of the cell at
column C, row 4.

À
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À
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Formula containing a cell reference entered in cell D4
Result of formula (3*12=36)

You can refer to a rectangular block of cells in a formula by entering the
location of the upper-left cell and the lower-right cell, separated by a
colon.
For example, =mean(B1:C5)*1. creates a result that is the mean of all cells
in the block bounded by columns B through C and rows 1 through 5. To
force the results of an expression to a decimal approximation, you
multiply by “1.”

À
À
Á

Á

Formula that refers to a rectangular block of cells
Result of formula

References such as C4 and C4:E11 are relative references. These
references describe a cell in relation to other cells. Lists & Spreadsheet
keeps track of relative cell references. It adjusts each reference
automatically when you copy or move the cell containing the reference
to another location in the spreadsheet.
If you need a reference that always refers to a cell in a specific location in
the spreadsheet, use an absolute reference. To create an absolute cell
reference, type a $ symbol before the column letter and row number. The
$ symbol is available in the Symbol Palette (/k).
For example, type $C$4 to create an absolute reference to the cell in
column C, row 4. Lists & Spreadsheet does not adjust absolute references
in a formula when you copy or move the cell containing the reference.

Inserting items from the Catalog
You can use the Catalog to insert system functions and commands,
symbols, and expression templates into a cell formula.
Using Lists & Spreadsheet
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1.

Select the cell and type “=“ to begin the formula.

2.

Press k to open the Catalog.

Note: Some functions have a wizard that prompts you for each
argument. If you prefer to enter the argument values directly in the
cell, you may need to disable the wizard.
3.

Press the number key for the category of the item. For example,
press 1 to show the alphabetic list.
shows an alphabetic list of functions and commands.
shows math functions and commands by category.
provides a symbol palette for adding special characters.
shows expression templates.
shows Public library (LibPub) objects.

4.

(LibPub)Press ¤ and then use ¡, ¢, £, or ¤ as necessary to select the
item that you want to insert.
Note: To see syntax examples of the selected item, press e, and
then press · to alternately show or hide the Help. To move back to
the selected item, press g e.

5.
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Press · to insert the item into the entry line.
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Deleting the contents of a cell or block of cells
1.

Press ¡, ¢, £, or ¤ to select the cell. (You can also hold down the g
key and then press ¡, ¢, £, or ¤ to select a rectangular block of
cells.)

2.

Press ..
The selected cell contents are deleted.

Note: If other cells contain formulas that refer to the cell’s previous
contents, those cells show an error.

Copying a cell or block of cells
When you copy cells, the formulas (if any) in the original cells are copied
to the destination cells, replacing the previous contents of those cells.
1.

Press ¡, ¢, £, or ¤ to select the cell. (You can also hold down the g
key and then press ¡, ¢, £, or ¤ to select a rectangular block of
cells.)
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2.

Press / C.
The selected cell contents are copied to the Clipboard.

3.

Select the cell where you want to duplicate the copied cell. If you are
copying a block of data, select the cell that will become the upper
left corner of the copied block.

4.

Press / V.

Note: Paste copied data into a cell that is in the same mode as the cell
from which the data was originally copied. Otherwise, a formula could
paste as a string enclosed in quotes instead of a formula.

Filling adjacent cells
You can repeat a cell’s formula or value throughout adjacent cells. This
gives you a quick way to fill cells with the same value or create a series of
cells that contain the same formula. You can fill down within a column.
1.

Select the cell whose value or formula you want to repeat.

2.

Press b to display the Lists & Spreadsheet menu.

3.

On the Data menu, select Fill Down.
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4.

Press ¤ repeatedly to move down, selecting the range of cells that
will hold the repetitions.

5.

Press ·.
The selected cell is duplicated throughout the selected range.

Notes
•

In step 1, you can select more than one cell to be repeated. If you do,
make sure that you select enough destination cells to hold the
repeated copies.

•

If you select multiple cells in step 1 and the cells contain a simple
sequence (such as 1,2,3 or 5,10,15,20), the sequence is continued in
the filled area.

Working with rows and columns of data
Selecting a row or column
f

Move to the top of the column, and then press £.
– or –
Move to the leftmost cell of the row, and then press ¡.

Resizing a row or column
1.

Select the row or column that you want to resize.

2.

Press b to display the Lists & Spreadsheet menu.

3.

On the Actions menu, select Resize.

4.

Use ¡ and ¢ to resize the column, or use £ and ¤ to resize the row.

5.

Press ·.

Inserting an empty row or column
1.

Select the column or row where you want to insert the new data.

2.

Press b to display the Lists & Spreadsheet menu.

3.

On the Insert menu, select either Row or Column.
–

If you are inserting a row, the remaining rows shift down to
create space for the new row.

–

If you are inserting a column, the remaining columns shift right
to create space.

Note: If other cells contain formulas with relative references to a
displaced row or column, those references adjust accordingly.
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Deleting entire rows or columns
You can delete a row, column, group of rows, or group of columns. When
you delete a row or column, the remaining rows or columns move up or
left to fill the gap.
1.

Select the column or row that you want to delete.

2.

If you are deleting more than one row or column, hold down g,
and press ¡ and ¢ to select additional columns or press £ and ¤ to
select additional rows.

3.

Press ..
The selected rows or columns are deleted.

Note: If other cells contain formulas that refer to the deleted row or
column, those cells show an error. Relative references to cells whose
positions have changed because of a deletion adjust accordingly.

Copying rows or columns
1.
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Select the column or row that you want to copy.
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2.

If you are copying more than one row or column press g, and then
press £, ¤, ¡, or ¢ to select an additional item.

3.

Press / C to copy the selected items.
The selected rows or columns are copied to the Clipboard.

4.

Move to any cell in the row or column where you want to place the
copied items.

5.

Press / V to paste the selection.
The copied row or column is pasted in place, replacing the previous
contents.

Moving a column
1.

Select the column that you want to move.

2.

Press b to display the Lists & Spreadsheet menu.

3.

On the Actions menu, select Move Column. An insertion bar
appears.

4.

Press ¡ or ¢ to place the insertion bar at the column’s new position,
and then press ·.
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Note: Relative references to any cell whose position is affected by
the move adjust accordingly.
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Using Data & Statistics
The Data & Statistics application provides tools to:
•

visualize sets of data in different types of plots.

•

directly manipulate data sets to explore and visualize data
relationships. Data changes in one application are dynamically
applied to all linked applications.

•

explore central tendency and other statistical summary techniques.

•

fit functions to data.

•

create regression lines for scatter plots.

•

graph hypothesis tests and results (z- and t-tests) based on summary
statistics definitions or data.

Note: In the following example, Lists & Spreadsheet is shown along with
Data & Statistics. This represents a typical page set-up.

À

Á

À
Á

Problem/Page number counter
Sample Data & Statistics work area

Using Data & Statistics

107

The Tool menu
Press b to open the Tools menu. These menus and tools enable you to
graph and explore data, modify data presentations by using different
plots, as well as perform and plot statistical analyses.
The following tables describe what each tool does in the Data & Statistics
work area.

Tool Menus
Menu

Overview of Tool Actions

Plot type

Provides access to the different plot types
available in the Data & Statistics application.

Plot properties

Allows you to specify how the plot displays

Actions

Lets you add/remove items to your work area.
This includes movable lines for manually fitting
data, regression curves and functions.

Window/Zoom

Lets you specify a zoom factor for the window,
or determine min and max values for the
horizontal and vertical axes.

Plot Types Menu Tools
Tool name

Tool function

Dot Plot

Depicts data in a dot plot. This is the
default plot type for a single variable of
the data set.

Box Plot

Displays data in a box plot.

Histogram

Displays data in a histogram.

Normal Probability Plot Displays data in a normal probability
plot. Data is grouped against the z-value
that corresponds to its quartile/normal
score. This plot type is useful for checking
for normality and determining the
appropriateness of a normal model.
Scatter Plot
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Displays data in scatter plot form. This is
the default plot type for two variables of
the data set.
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Tool name
X-Y Line Plot

Tool function
Displays data as an x-y line plot.

Plot Properties Menu Tools
Tool name

Tool function

Connect Data Points

Draws a line between each point on a
scatter plot. Lines are connected in the
order of data entry in the horizontal axis
data set. This is the same as the X-Y Line
plot type

Histogram Properties:

Determines how the histogram data
displays in the work area.

Count

Displays data in the histogram by
occurrence in the data set.

Percent

Displays data in the histogram by each
bin’s percent value of the whole data set.

Density

Displays data in the histogram by data
density.

Bins

Displays a dialog for setting the histogram
values for bin width and alignment.

Extend Box Plot
Whiskers/ Show Box
Plot Outliers

Extend Box Plot Whiskers extends the
whiskers to the min and max of the data.
Show Box Plot Outliers stops at 1.5*
Interquartile Range and shows outliers as
individual dots.
Note: If there are no points outside of
1.5* Interquartile Range, there may
appear to be no whisker change.

Add X Variable

Adds a variable to the horizontal axis
when no variable is assigned.

Remove X Variable

Removes the display of the variable
assigned to the horizontal axis without
changing the vertical axis.

Add Y Variable

Adds a variable to the vertical axis to
support the plotting of multiple variables.
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Tool name
Remove Y Variable

Tool function
Toggles the display of the variable
assigned to the vertical axis without
changing the horizontal axis.

Actions Tool menu
Tool name
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Tool function

Select all Points

Selects all points in the work area.

Add Movable Line

Adds a line you can position and
reposition in the work area. This can be
used for manual fit.

Remove Selected

Removes the selected object. Changes to
Remove Movable Line, Remove
Regression, Remove Plotted Value,
Remove Plotted Function, depending on
what is selected.

Lock Intercept at
Zero/Unlock Movable
Line Intercept

Locks the intercept of the movable line at
zero. Note: This tool is only available
when a movable line or regression line is
present in the work area.

Regression

The regression tools perform the selected
regression calculation and then plot the
regression model. Regressions are only
available on Scatter plots of X-Y line plots.

Show/Hide Linear
(mx+b)

Calculates and displays the linear
regression line in the format, mx+b, for
the plotted data.

Show/Hide Linear
(a+bx)

Calculates and displays the linear
regression line in the format, a+bx, for
the plotted data.

Show/Hide MedianMedian

Calculates and displays the MedianMedian regression line for the plotted
data.

Show/Hide Quadratic

Calculates and displays the Quadratic
regression model for the plotted data.

Show/Hide Cubic

Calculates and displays the Cubic
regression model for the plotted data.
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Tool name

Tool function

Show/Hide Quartic

Calculates and displays the Quartic
regression model for the plotted data.

Show/Hide Power

Calculates and displays the Power
regression model for the plotted data.

Show/Hide Exponential Calculates and displays the Exponential
regression model for the plotted data.
Show/Hide Logarithmic Calculates and displays the Logarithmic
regression model for the plotted data.
Show/Hide Sinusoidal

Calculates and displays the Sinusoidal
regression model for the plotted data.

Show/Hide Logistic
(d=0)

Calculates and displays the Logistic
regression model where D=0, for the
plotted data.

Show/Hide Logistic
(dƒ0)

Calculates and displays the Logistic
regression model where Dƒ0, for the
plotted data.

Show/Hide Residual
Squares

Displays the squares of residuals. Note:
This tool is only available when a
regression line or movable line is present
in the work area.

Plot Value

Lets you graph a statistical value on the
axis. Examples of values that can be
plotted are mean, median, standard
deviation.

Plot Function

Lets you graph a function in the work
area.

Shade Under Function

Lets you select and shade a region under a
function or distribution curve.

Start Over

Erases the content on the page without
saving any work. This enables you to start
your work again.
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Window/Zoom Menu Tools
Tool name

Tool function

Window Settings

Displays a Window Settings dialog that
enables you to enter values that define
the work area window. Values you can set
include the x-min, x-max, y-min, and ymax values for the axes.

Zoom - Data

Adjusts the zoom factor so that all plotted
data appears in the work area.

Zoom In

Enables you to zoom in on a plot based
upon the selection of a center point. The
Zoom In factor is approximately 2.

Zoom Out

Enables you to zoom out on a plot based
upon the selection of a center point. The
Zoom Out factor is approximately 2.

Working with Data & Statistics
The Data & Statistics application is designed as a place to explore and
visualize data and graph inferential statistics. It is, therefore, best used in
conjunction with a numerical application like Calculator or Lists &
Spreadsheet.

Creating plots from spreadsheet data
The Quick Graph feature of Lists and Spreadsheet is the easiest way to
plot data using the columns in a spreadsheet.

Plotting data from Lists & Spreadsheet
1.

Create or display data to be plotted in Lists & Spreadsheet. You can
plot one or two columns of data.
The example below illustrates two named columns, height and
weight.
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Important: You must name each column of data in Lists &
Spreadsheet in order to plot the data in Data & Statistics.
2.

Highlight at least one column of data in Lists & Spreadsheet.

3.

From the Lists & Spreadsheet Data menu
Graph tool.

, select the Quick

Press: b 3 4.

The data plot displays in the Data & Statistics work area.
The example below illustrates the plot of two columns of data,
which display as a scatter plot. The leftmost column of data in the
spreadsheet becomes the horizontal axis values, and that column
name becomes the horizontal axis label.
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The data plot functions as follows:
–

If you select only one column of data, it displays as a dot plot on
the horizontal axis. The column name appears as the horizontal
axis label.

–

If spreadsheets in the problem contain multiple named lists, you
can view the names of lists in the problem by positioning the
mouse over an axis and clicking
. Remove
the plotted variable and click on the name of any list to replace
the data plotted on the axis with the data in the selected list.

–

If there are less than four work areas on the page, TI-Nspire adds
a new work area with Data & Statistics active on it.

–

If four work areas are already defined on the page, TI-Nspire
adds a new page to the problem with Data & Statistics active on
it.

Note: If a list is defined with a formula in Lists & Spreadsheet, the
points in Data & Statistics may not move, due to the formula’s
restriction. The dots in Data & Statistics will only move in directions
allowed by their definition, so if they are just data they will move
freely. If the points are y=x, they will move along the line.

Creating a split page with Data & Statistics and Lists &
Spreadsheet
1.

Add the Lists & Spreadsheet or Calculator application to a new page
or problem.

2.

Click
two work areas.
Press:
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and select Layout 2

, to split the page into

/ c622
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3.

Click to add the Data & Statistics Application to the right side of the
work area.

More Information
More in-depth information, step-by-step instructions, and examples of all
the Data & Statistics features are contained in the Data & Statistics
chapter of Part 2 of the user guide, available on the CD that came with
your handheld, or on the web site at http://education.ti.com/guides.
Please refer to this material to gain a thorough understanding of all the
capabilities of the application.
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Using Notes
Getting started with the Notes application
The Notes application provides text editing functions that allow you to
create and share documents with others using the TI-Nspire™ handheld
and computer software.
You can use the Notes application as a tool to create study notes to
reinforce your understanding of classroom concepts and to review for
exams. The Notes application allows you to assign different roles to
individuals using your document, so that any edits appear in a different
text format, making it easy to edit collaboratively.

À

Á
À

Notes tool menu – This menu is available anytime you are in the
Notes work area. Press b to display the menu.

Á

Notes work area -- The area where you enter and format text.
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The Notes tool menu
The Notes tool menu lets you select a Notes template, format text, and
evaluate expressions. The table below describes the menu items and their
functions.
Menu
Name

Menu Option

Function

Templates
Q&A

Creates a template to enter question
and answer text.

Proof

Creates a template to enter statement
and reason text.
Lets you enter freeform text.

Default
Insert
Lets you insert a math expression.
Expression Box
Shape

Comment

Marks the selected text as an angle,
triangle, circle, line, segment, ray, or
vector.
Lets you enter text that is italicized and
prefaced with Teacher or Reviewer.

Format
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Keyword

Toggles the selected text between bold
and not bold, and removes all other
formatting.

Title

Toggles the selected text between
underlined and not underlined, and
removes all other formatting.

Sub-heading

Toggles the selected text between italic
and not italic, and removes all other
formatting.

Using Notes

Subscript

Toggles the selected text between
subscripted and not subscripted, and
removes all other formatting.

Superscript

Toggles the selected text between
superscripted and not superscripted,
and removes all other formatting.

Actions
Evaluate
selection
Show or Hide
Answer

Replaces the selected math expression
with the result of the expression.
Shows or hides the answer in a Q&A
template.

Before you begin
f

Turn on the handheld, and add a Notes application to a document.

The Notes work area
The Notes work area is where you enter and format text.

Notes templates
The Notes application provides templates for creating three types of
notes:
•

Q&A for questions and answers, with the answer shown or hidden

•

Proof for an outline structure containing statements and reasons

•

Default for open-formatted text entry

Using Notes

119

Applying a Notes template
1.

While in the Notes work area, press b to display the Notes menu.

2.

On the Templates menu, select the specific template to apply.

Using the Q&A Template
Use the Q&A template to create questions and answers. You have the
option to show or hide the answer, so you can create questions for
review and hide the answers. When you use the document as a study aid,
you can verify that your answers are correct.
Press e to move the text cursor between the Question and Answer
areas of the template.

Using the Proof Template
The proof template provides an outline structure for statements and
corresponding reasons.
Press e to move the text cursor between the Statements and Reasons
areas of the template.
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Inserting comments
You can insert Teacher or Reviewer comments into a Notes application.
Comments are easily identifiable and easy to distinguish from the
original text.
1.

While in the Notes work area, press b to display the Notes menu.

2.

On the Insert menu, select Comment, and then select Teacher or
Reviewer.

3.

Enter your text.
Text that you enter appears in italics.

Formatting Notes text
Notes allows you to format text to add context to your documents. Use
the tools on the Text options menu to specify text as a keyword, title or
subheading, or to format text as subscript or superscript.

Selecting text
1.

If you are using the Q&A or Proof template, press e to place the
cursor in the area containing the text.

2.

Use the NavPad to place the cursor at the start or end of the text to
be selected.

3.

Hold down g, and use the NavPad to select the text.

Applying a text format
1.

Select the text in the Notes work area.

2.

Press b to display the Notes menu.

3.

On the Format menu, select the name of the format to apply.
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Note: You can restore the text to normal by reapplying the same
format.

Inserting geometric shape symbols
You can use geometric shape symbols to designate selected text as
geometric objects, such as an angle, circle, or line segment.
1.

Position the cursor where you want to insert a shape symbol.

2.

Press b to display the Notes menu.

3.

On the Insert menu, select Shapes, and then select the shape to
apply.

Entering and evaluating expressions
You can include math expressions in Notes text, using the same tools as in
other TI-Nspire™ applications. You can also evaluate an expression and
display the result.
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Entering an expression
1.

In the Notes work area, place the cursor where you want the
expression.

2.

Press b to display the Notes menu.

3.

On the Insert menu, select Expression Box.

4.

Type the expression. You can use the Catalog, if necessary, to insert a
function, command, symbol, or expression template.

Evaluating an expression
Note: The result of the expression will replace the expression. If you
need both the expression and its result, make a copy of the expression
and then evaluate the copy.
1.

Select the entire expression.

2.

Press b to display the Notes menu.

3.

On the Actions menu, select Evaluate Expression.
The result replaces the expression.
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123

124

Using Notes

Data Collection
The Data Collection tool enables you to collect experimental information
from a sensor and automatically display it in a table and/or graph for
analysis. It uses the Lists & Spreadsheet and Graphs & Geometry
applications to do this.

Compatible sensors
Data Collection is capable of interacting with the following sensors:
•

Vernier EasyTemp®

•

Texas Instruments CBR2™ Motion Detector

•

Vernier Go!®Temp

•

Vernier Go!®Motion

Experimental data
The Data Collection tool currently collects distance or temperature data
points at regular intervals over time. Units of measure cannot be
changed.
The table below shows the number of samples and sampling interval for
the sensors currently supported.
Sensor

Number of
Samples

Sampling
Interval

Test Duration

Vernier EasyTemp®

180

1 second

180 seconds

Texas Instruments CBR2™
Motion Detector

100

0.05 second

5 seconds

Vernier Go!®Temp

180

1 second

180 seconds

Vernier Go!®Motion

100

0.05 second

5 seconds

Starting the Data Collection tool
The Data Collection tool can be started automatically or manually.
f

An automatic start occurs when a sensor is connected to either a
TI-Nspireé handheld or a computer running TI-Nspireé computer
software. The connected sensor will be configured to work with the
Data Collection tool in an open Graphs & Geometry page, or if
Graphs & Geometry is not on the active page, a new page will be
opened and the page will display Graphs & Geometry and Lists &
Spreadsheet.

f

The Data Collection tool can be manually added to any Graphs &
Geometry application page. When the tool is added, it will try to
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configure itself using the first available sensor. Any sensor that is
already being controlled by a Data Collection tool is considered
unavailable.

Data Collection controls
The Data Collection tool controls available are:
Icon

Name

Function

Start Data
Collection

Initiates data collection.

Stop Data
Collection

Stops data collection. The graph of existing data
points is shown, and for motion experiments,
velocity and acceleration data for the points are
also available.

Close

Close button. Completely closes the control box. If
this button is selected when data collection is in
progress, all data collection stops. The plot is
erased. If Lists & Spreadsheet is on the page, the
data points collected are shown in the columns. For
motion experiments, velocity and acceleration data
is not provided.

Running an experiment and collecting data
1.

When the desired sensor is connected and the Data Collection page
is set up as desired, press the Start icon ( ).

2.

If Lists & Spreadsheet is on your page, you see each sample collected
populate the rows in the table. The sampling data points are plotted
on the graph.

3.

When all data points are collected, Data Collection automatically
stops. If desired, you can press Stop (
experiment.

4.

) prior to the end of the

To rerun the experiment without retaining the current data, press
START ( ). The data displayed is erased when the new experiment is
started.

Data Collection names
The naming system for Data Collection data includes a group designator
and a member designator (group.member). For example, in a
temperature versus time experiment, the data is named run0.temp_C and
run0.time_s. Remember that TI-Nspireé computer software is case
insensitive: RUN0.TEMP_C and run0.temp_c reference the same set of
data.
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Storing collected data
To save the current data before rerunning an experiment, use the
following instructions.

To save temperature data
1.

Cut and paste each column of data into new columns. The first two
columns (Columns A and B) will be reused by the next run of the
experiment.

2.

Rename each moved column.

Repeat the steps for each data sample you want to save. To permanently
save a set of data generated by an experiment, save the document.

To save motion data
1.

Cut and paste each column of data into new columns.
The first two columns (Columns A and B) will be reused by the next
run of the experiment.

2.

Rename each moved column.

3.

To save velocity data, select a third column. Highlight the column,
and select

. Select Link to: and choose the velocity variable.

The column is filled with the velocity values for the experiment.
Rename the column with a unique name.
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4.

Repeat this procedure to save acceleration data.

5.

Repeat the steps for each experimental data set you want to save.

To permanently save a set of data generated by an experiment, save the
document.
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Appendix: Service and Support
Texas Instruments Support and Service
For general information
For more information about TI products and services, contact TI by e-mail
or visit the TI Internet address.
E-mail inquiries:

ti-cares@ti.com

Home Page:

education.ti.com

Service and warranty information
For information about the length and terms of the warranty or about
product service, refer to the warranty statement enclosed with this
product or contact your local Texas Instruments retailer/distributor.

Service
Refer Servicing to Qualified Service Personnel under the Conditions
Listed Below:
•

If liquid has been spilled or objects have fallen into the product.

•

If the product has been exposed to rain or water.

•

If the product does not operate normally as per the operating
instructions.

•

If the product has been dropped or the case has been damaged.

Battery Precautions
Take these precautions when replacing batteries.
•

Do not leave batteries within the reach of children.

•

Do not mix new and used batteries. Do not mix brands (or types
within brands) of batteries.

•

Do not mix rechargeable and non-rechargeable batteries.

•

Install batteries according to polarity (+ and - ) diagrams.

•

Do not place non-rechargeable batteries in a battery recharger.

•

Properly dispose of used batteries immediately.

•

Do not incinerate or dismantle batteries.
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Disposing of Batteries
•
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Do not mutilate, puncture, or dispose of batteries in fire. The
batteries can burst or explode, releasing hazardous chemicals.
Discard used batteries according to local regulations.
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